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Revision Control

Part Number Revision Software Version Description Release Date
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Federal (U.S.A.) law restricts this device to sale, distribution and use by or on the
order of a physician. Proper procedures and techniques are the responsibility of
the medical professional.

It is the operator’s responsibility to use, check, and maintain this device according to the
labels of the product, accompanying instruction manuals, and any revisions of the
labeling or instructions that may be subsequently issued.

License and use of the iVue system is intended only for trained medical
personnel in accordance with the license agreement — all other usage is
prohibited — warranty restrictions and possible claim limitations apply.

Standard Warranty Information

See the warranty section of Optovue.com for all product warranty and customer
licensing agreements.

Service Policy

Only those service technicians certified by Optovue, Inc. are authorized to service or
repair this device. Only those replacement parts approved by Optovue, Inc. may be
used in this device. Parts approved by Optovue, Inc. are available only through service
technicians certified by Optovue, Inc. Any service or repair by an unauthorized service
technician or use of unapproved parts will void the Optovue, Inc. product Warranty, and
may increase risk of product failure. For any problem, for technical assistance or to
arrange for service, contact: Optovue Technical Support or Optovue Customer Service
at the numbers listed below; your local Optovue, Inc. company or authorized distributor.

If the device is to be returned, Optovue or your authorized distributor will provide
instructions for returning the device and will issue a Returned Material Authorization
(RMA) number. For contaminated devices, request the appropriate Product Return
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Safety Pack. Returned devices must be packaged with adequate protection against
shipping damage. Include a note describing the problem, stating the RMA number, and
giving the name, address, and telephone number of a person to contact for additional
information.

Copyright © 2015 Optovue, Incorporated. All rights are reserved. No part of this
publication may be stored in a retrieval system, transmitted or reproduced in any way,
including but not limited to photocopy, photograph, magnetic or other record, without the
prior agreement and written consent of Optovue, Inc.

Trademarks

iScan and Optovue are trademarks of Optovue, Inc. Other trade names are the property
of their respective owners, and are hereby acknowledged.
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1 Introduction

1.1 General

Optovue, Inc. has developed and tested this instrument in accordance with Optovue,
Inc. safety standards, as well as national and international regulatory guidelines and all
applicable safety standards to ensure a high degree of instrument safety. Observe all
labeling related to safety, including information and notes in this manual and on the
device labels. This device does not produce any waste that needs disposal. This
product contains no material that presents a chemical hazard concern.

1.1.1 Proper Instrument Use
¢ Always enter patient information first.
¢ Clean the system facemask as necessary between patients.

e The power cord is the only way to disconnect the system completely from
the power source. For any emergency, turn the system power OFF, then
immediately unplug the power cord from the wall or from the system.

¢ Clean the ocular lens frequently to ensure good image quality.

« Warn others not to sit or stand on any part of the table, including the base
and the top.

¢ When lowering the table, make sure that pinch point areas are clear of
people and articles; do not store articles in these areas.

e To avoid pinching the patient, check the patient’s head position before
raising the chin rest.

¢ Adjust table and/or chair height properly to ensure patient comfort during the
examination.

e Use the small facemask if appropriate for the patient or when performing anterior
scans. The patient’s forehead should make good contact with the forehead rest
to enable the sensors.

¢ Dim the room lights to allow natural dilation of the patient’s pupil, and to reduce
glare and provide comfortable visualization of the fixation target.

[1;;' Note: Chemically induced pupil dilation is not normally needed.

== Note: For cornea scans, attach the CAM lens (cornea lens) before positioning
the patient. See section 4.1.1.
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1.1.2 Intended Use

The iScan system is an optical coherence tomography system intended for in vivo
imaging, axial cross-sectional, three-dimensional imaging and measurement of anterior
and posterior ocular structures.

1.1.3 Indications for Use

The iScan system is a non-contact, high resolution tomographic imaging device. It is
intended for in vivo imaging, axial cross-sectional and three-dimensional imaging and
measurement of anterior and posterior ocular structures, including retina, retinal nerve
fiber layer, ganglion cell complex (GCC), optic disc, cornea, and anterior chamber of the
eye. The iScan system is a quantitative tool for the comparison of retina, retinal nerve
fiber layer, ganglion cell complex, and optic disc measurements to a database of known
normal subjects. The iScan system with Normative Database is intended for use as a
device to aid in the diagnosis, documentation, and management of ocular health and
diseases in the adult population.

o Contraindications
This device is not designed, sold or intended for use except as indicated.

%5 'Note: The iScan system is not intended to be used as the sole diagnostic aid in
disease identification, classification or management. The iScan system
provides data to be used in conjunction with other information and is
intended to assist an eye care clinician in determining a diagnosis. A patient
diagnosis is the sole domain of a licensed eye care clinician.

1.1.4 Equipment Classification
o Type of protection against electric shock: Class 1
e Degree of protection against harmful ingress of water: IPX0

¢ Class of operation: Continuous

1.1.5 Certification

To ensure full system quality, the iScan system has been manufactured in a registered
ISO 9001 or 13485 facility. It has been designed and tested to be compliant when used
with the laboratory equipment requirements of applicable regulatory agencies.
Declarations of conformity and certificates of compliance are available at
www.optovue.com.
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1.2

System Overview

These are the primary components with which users interact regularly.

iScan unit: The iScan unit consists of an integrated scanner, computer and
monitor. It scans the patient eye, collects the OCT signal and displays the report.
It includes fixation target lights to enable patients to fixate properly during the
scan. The system uses a medical-grade power supply.

Mouse and keyboard (additional monitor optional): The mouse and keyboard
plug into the system and augment the touch-screen. As an option, you can
connect an additional monitor.

Small facemask: The small facemask fits in the forehead and chinrest. Use it
when doing anterior segment (corneal) scans or when the patient has a smaller
head, to achieve the correct head position.

Dust cover, lens cap: Protect the system and lens when device not in use.

Verification tool: The system must be checked after delivery with the verification
tool prior to patient scanning. Upon delivery, the scan tab is disabled until the
system passes the test. Repeat the test if you transport the system or if there is a
concern that the system may have been damaged.

1.2.1 System Components
The following figures identify system components.

Computer
touchscreen

Power and USB
connections

Power button

Compartment for
cornea lens

Keyboard and
mouse

Figure 1 System Front View
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Facemask with
forehead sensor

External
fixation lights

Lock point for
travel—unlock
before use

Figure 2 System Rear View

1.3 System Warnings

system status through the USB. Whenever software detects abnormality in
status, it halts operation and flags error messages to warn users. Upon
seeing the error messages, exit the application program and reboot the
system.

f WARNING: During normal usage of iVue, software periodically polls the

WARNING: No modification of this equipment is allowed.

WARNING: Do not modify this equipment without authorization of the
manufacturer.

WARNING: If this equipment is modified, appropriate inspection and
testing must be conducted to ensure continued safe use of the equipment.

WARNING: It is recommended that no accessories other than those
specifically called out in this User's Guide may be connected to the system.
Any customer accessory equipment connected to the interface ports must
be certified according to the respective IEC standards (e.g. IEC 60950 for
data processing equipment and IEC 60601-1 for medical equipment) Also,
all configurations shall comply with the system standard IEC 60601-1:2005.
Any person who connects or installs accessories to the system has the
responsibility to verify the compliance. If in doubt, consult an Optovue
representative.
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1.4 General Warnings

A\

> B B

ESD WARNING: Before assembly, installation or interconnection of the
iScan, it is recommended that all staff personnel (that is, biomedical
engineers and health care staff) that could touch connectors identified with
the ESD warning symbol undergo electrostatic discharge (ESD) training. At
minimum, ESD training should include an introduction to the physics of
electrostatic charge, the voltage levels that can occur in normal practice
and the damage that can be done to electronic components if they are
touched by an operator who is electrostatically charged. Furthermore, an
explanation should be given of methods to prevent build-up of electrostatic
charge, and the how and why to discharge one’s body to earth or to the
frame of the equipment or system, or bond oneself by means of a wrist
strap to the equipment or system or to earth prior to making a connection.
Finally, staff must be made aware that accessible pins of connectors
identified with the ESD warning symbol should not be touched with the
fingers or with a handheld tool unless proper precautionary procedures
have been followed.

WARNING: The use of accessories, transducers and cables other than
those specified may result in increased electromagnetic emissions or
decreased electromagnetic immunity of the iScan.

WARNING: Components of the iScan should not be used adjacent to or
stacked with other equipment and that if adjacent or stacked use is
necessary, the iScan system should be observed to verify normal operation
in the configuration in which it will be used.

WARNING: The iScan system cannot replace clinical judgment and is
intended to be used only in conjunction with other clinical tools considered
to be the standard of care for diagnosis of eye health and disease.

The iScan system is not intended to be used as the sole diagnostic aid in
disease identification, classification or management. The iScan system
provides data to be used in conjunction with other information, intended to
assist an eye care clinician in determining a diagnosis. A patient diagnosis
is the sole domain of a licensed eye care clinician.
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WARNING: Equipment is not suitable for use in the presence of a
Flammable Anesthetic Mixture with Air, Oxygen, or Nitrous Oxide.

WARNING: The iScan system has no special protection against harmful
ingress of water or other liquids (classified IPX0). To avoid damage to the
instrument and cause a safety hazard, the cleaning solutions, including
water, should not be directly applied to the device. Using a dampened cloth
(without dripping), is a good method to clean the exterior surface of the
enclosure. The table can be cleaned in the same manner as the iScan
instrument. Care should be taken to avoid excessive fluid near any of the
system components.

> B

his or her body to an electrical device that is not powered by the iScan
system. In addition, while examining the patient, the operator of the iScan
system must not touch at the same time the patient and any electrical
device that is not powered by the iScan system. Failure to observe these
warnings could result in electrical shock to the patient and/or operator.

f WARNING: While being examined, the patient must not touch any part of

WARNING: Use power cords provided only by Optovue. Do not block
access to unplug the power cord.

>

To remove power from the iScan system, you must disconnect the
mains plug from the wall outlet. Do not position system where plugs
are inaccessible during operation.

Caution: The Normative Database and the results displayed based on
estimated percentiles should be used only as an aid for making clinical
decisions. The results from the normative database comparison should
never be used in isolation, only as one part of the entire clinical
armamentarium. Patients who are not represented by the patients in the
normative database may not be suitable for comparison to the normative
database. In these patients, the normative database results should be used
with caution, if at all. This includes patients outside the age range of the
normative database (outside 18 — 82 years of age), or outside the range of
refractive error (worse than 8 diopters spherical error or 2 diopters
cylindrical error). Results in patients 30 years of age or younger and 80
years of age or older should be interpreted with caution since only 4
subjects below the age of 30 and three subjects above the age of 80 were
included in the normative database. It should be noted that this normative
database does not have any subject younger than 18 years of age. The
color categorization of a pixel presents the percentile with regard to the
distribution of thickness at the specific location of a given pixel.

>
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Caution: The color normative maps provide a way to represent whether a
given patient is similar or dissimilar to a “Normal” patient. This information
does not provide further diagnostic information beyond representing
whether a given patient is similar or dissimilar to a “Normal” patient.

Caution: Normative database comparisons are based on statistical
comparisons only, and there are possible normal outliers. Misclassification
risk can be reduced further by using multiple clinical tools for diagnosis.

Caution: OCT image is a plot of optical path length. Depending on the
optical design and scanning location, the image can be distorted from its
actually physical shape. For example, a relatively flat retinal OCT image
might not reflect the true curvature of the retina.

CAUTION: Federal law restricts this device to the sale by or on the order of
a Physician or Practitioner (CFR 801.109(b) (1).

1.4.1 WARNING: User Changes to Software or Hardware

>

The iScan system is a medical device. The software and hardware has
been designed in accordance with U.S., European and other international
medical device design and manufacturing standards. Unauthorized
modification of the iScan system software or hardware, or any addition or
deletion of any application in any way can jeopardize the safety of
operators and patients, the performance of the instrument, and the integrity
of patient data.

Any changes, additions or deletions to factory installed applications,
operating system or modifications to hardware in any manner VOIDS
the warranty completely and can cause safety HAZARDS.

1.4.2 WARNING: Phototoxicity

A\

Because prolonged intense light exposure can damage the retina, the use
of the device for ocular examination should not be prolonged
unnecessarily, and the brightness setting should not exceed what is
needed to provide clear visualization of the target structures.

The retinal exposure dose for a photochemical hazard is a product of the
radiance and the exposure time. If the value of radiance were reduced in
half, twice the time would be needed to reach the maximum exposure limit.
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While no acute optical radiation hazards have been identified for direct or
indirect ophthalmoscopes, it is recommended that the intensity of light
directed into the patient’s eye be limited to the minimum level which is
necessary for diagnosis. Infants, aphakes and persons with diseased eyes
will be at greater risk. The risk may also be increased if the person being
examined has had any exposure to the same instrument or any other
ophthalmic instrument using a visible light source during the previous 24
hours. This will apply particularly if the eye has been exposed to retinal
photography.

1.5 Standard Accessories

Description Part No. Quantity
User Manual 580-49328-004 | 1 pc.
Installation Manual | 810-49813-002 | 1 pc.

1.5.1 Cabling
Cable Name Type of Cable | Shielded or Unshielded | Max. Cable Length
Keyboard/Mouse, wireless UsSB Shielded Std.
Power Cord 3-wire Shielded 3.4 m

connections specified. Otherwise, it may result in fire or electric shock. For
details of purchasing accessories, contact an Optovue representative or
distributor. To avoid risk of electric shock, this equipment must only be
connected to supply mains with protective earth.

ZE WARNING: Do not connect the instrument with anything other than those

U%’?Note: Avoid the use of extension cords or a power strip.

1.6 Transport Instructions
Directives de manipulation

ﬂ"l’t’i'ﬁlmportant: Before moving the system, lock the base to prevent damage during
transport. Remove the cover of the lock point on the back of the unit (from
the operator’s perspective) and use the slot screwdriver provided to turn the
bar %4 turn counterclockwise. (In this case, counterclockwise is to lock.
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Clockwise is to unlock.) Replace the cover of the lock point. When the move
is complete, unlock the base again before using the system.

Lock point for travel

Figure 3 Lock Base Before Moving System
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1.7 Product Compliance

1.7.1 CB Certification: Under IEC 60601-1
This device is classified according to UL/IEC/BS EN 60601-1 (2005) as follows:

Mobile, Continuous Operation, Class 1, Type B.

With respect to electrical shock, fire and mechanical hazards only in accordance with
UL/IEC/BS EN 60601-1 Third edition (2005) and CAN/CSA C22.2 No. 601.1.

ON for part of the Equipment.

NN Alternating Current

1.8 Radio Interference

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of FCC rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with this user manual,
may cause interference to radio communications. Operation of this equipment in a
residential area is likely to cause interference, in which case users will be required to
correct the interference at their own expense.

1.8.1 Canadian Regulations

This equipment does not exceed the Class A limits for radio noise emissions from digital
apparatus as set out in the radio interference regulations of the Canadian Department of
Communications.
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1.8.2 Electromagnetic Compatibility (EMC): EN 60601-1-2:2007

The iScan system has been tested to comply with the emission and immunity
requirements of IEC 60601-1-2 / BS EN 60601-1-2:2007. The iScan system is intended
for use in an electromagnetic environment where radiated RF disturbances are not
beyond the standard defined in IEC 60601-1-2 / BS EN60601-1-2:2007.

GUIDANCE AND MANUFACTURER’S DECLARATION — ELECTROMAGNETIC EMISSIONS

The iScan system is intended for use in the electromagnetic environment specified below. The iScan
system customer or user should ensure that it is used in an appropriate environment.

Emissions Test | Compliance Electromagnetic Environment - Guidance

RF emissions The iVue uses RF energy only for its internal function. Therefore, its

CISPR 11 Group 1 RF emissions are very low and are not likely to cause any

EN 55011 interference in nearby electronic equipment.

RF emissions The iScan system is suitable for use in all establishments other than

CISPR 11 Class A domestic, and may be used in domestic establishments and those

EN 55011 directly connected to the public low-voltage power supply network

Harmonics that sgpplies buildingg used for domestic purposes, provided the

IEC/EN 61000-3- | Class A following WARNING is heeded:

> WARNING: This equipment/system is intended for use by healthcare
professionals only. This equipment/ system may cause radio

Flicker interference or may disrupt the operation of nearby equipment. It may

IEC/EN 61000-3- | Complies be necessary to take mitigation measures, such as re-orienting or

3

relocating the iScan system, or shielding the location.

GUIDANCE AND MANUFACTURER’S DECLARATION — ELECTROMAGNETIC IMMUNITY

The iScan system is intended for use in the electromagnetic environment specified below. The customer
or the user of the iScan system should assure that it is used in such an environment.

Immunity test IEC 60601 Compliance level Electromagnetic environment guidance
test level
An ESD warning label adjacent to the rear
Electrostatic +92 4 6KV USB connector and precautionary user
discharge (ESD) o + 2, 4, 6 kV contact | manual documentation are required. Floors
contact . S
+2 4 8KV air +2,4,8kV air should be wood, conprete or ceramic t|!e. If
IEC/EN 61000-4-2 |~ ™ floors are covered with synthetic material, the
relative humidity should be at least 30%.
iOZWI;\: ;?Jr E: 2 kV for power
Electrical fast I?nes PRy supply lines
transient/burst Mains power quality should be that of a
+ 1KV f + 1 kV for typical commercial or hospital environment.
IEC/EN 61000-4-4 | = or input/output
input/output lines
lines

iScan User Manual
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GUIDANCE AND MANUFACTURER’S DECLARATION — ELECTROMAGNETIC IMMUNITY

. . +1kVline(s) |+1KkVline(s)to

Surge Line to Line t0 line(s) line(s)

(AC Power) Mains power quality should be that of a
+ 2KV line(s) | +2 KV line(s) to typical commercial or hospital environment.

IEC/EN 61000-4-5
to earth earth

Radiated RF 80 MHz - 2.5 80 MHz - 2.5 GHz Port.able and mobile RF communications
GHz equipment should be used no closer to any

IEC/EN 61000-4-3

3Vim 80% @
1 kHz

3V/m80% @ 1
kHz

part of the Optical Coherence Tomography
System, including cables, than the
recommended separation distance calculated
from the equation applicable to the frequency
of the transmitter.

Recommended separation distance

d = (3.5/E1)VP 80 MHz to 800 MHz

d = (7 /E1)VP 800 MHz to 2.5 GHz

where P is the maximum output power rating
of the transmitter in watts (W), according to

0.15 - 80 MHz the transmitter manufacturer and d is the
3C\:/"m3 1 kHz recommended separation distance in meters
AC Mains 0.15-80 MHz (m)
Conducted RF :
" 0.15-80 3 Vrms 1 kHz Conducted Immunity:
IEC/EN 61000-4-6 !
MHz AC Mains d=(3.5VIP
3 Vrms 1 kHz Field strength from fixed RF transmitters, as
AC Mains determined by an electromagnetic site
survey, should be less than the compliance
level in each frequency range. Interference
may occur in the vicinity of equipment marked
with the following symbol.
()
<5% UT
(>95 % dip in
ur) <5% UT
for 0,5 cycle (>95 % dip in UT)
for 0,5 cycle
. 40 % UT . .
Voltage dips, short o) A o Mains power quality should be that of a
. . (60 % dip in 40 % UT : X . :
interruptions and o/ A : typical commercial or hospital environment. If
o ur) (60 % dip in UT) . ;
voltage variations the user of the iScan system requires
for 5 cycles for 5 cycles - : : .
on power supply continued operation during power mains
nouines 0% UT | 70%UT | Soan systom be powered froman
(s] 0 . .
IEC/EN 61000-4-11 UT) for 25 cycles uninterruptible power supply or a battery.
for 25 cycles
<5% UT
<5% UT (>95 % dip in UT)
(>95 % dipin |for5s
urt)
for5s
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GUIDANCE AND MANUFACTURER’S DECLARATION — ELECTROMAGNETIC IMMUNITY

Power frequency
(50/60 Hz)
magnetic field

IEC/EN 61000-4-8

3 A/m

3 A/m

Power frequency magnetic fields should be at
levels characteristic of a typical location in a
typical commercial or hospital environment.

NOTE UT is the a.c. mains voltage before application of the test level.
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1.9 Symbols Explained
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Refer to or read user manual first

WARNING symbol indicates a potentially hazardous situation
which, if not avoided, could result in death or serious injury. May
be used to indicate the possibility of erroneous data that could
result in an incorrect diagnosis (does not apply to all products).

Caution symbol indicates a potentially hazardous situation,
which, if not avoided, may result in minor or moderate injury. It
may also be used to alert against unsafe practices. May be used
to indicate the possibility of erroneous data that could result in an
incorrect diagnosis (does not apply to all products).

Electrical shock hazard: Voltage present inside the instrument.
Do not remove the instrument cover or parts.

Note: Calls attention to important information for the user.

C € European Conformity Mark for TUV Rheinland
0197 European Notified Body:
TUV Rheinland LGA Products GmbH
Tillystrasse 2
90431 Nuremburg Germany

Type B applied part: This instrument complies with the specified
requirements to provide protection against electrical shock,
particularly regarding allowable patient leakage current.

Manufacturer

Optovue, Inc.

2800 Bayview Drive,
Fremont, CA., USA, 94538
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0 General mandatory action sign

Authorized European Community Representative
| EC |REP| Medical Device Safety Services (MDSS) GMbH
Schiffgraben 41
30175 Hannover, Germany

@ Serial number

REF Catalog number / part number

Do not sit on

Do not stand on

Do not push

WARNING: Hand crush hazard
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1.9.1 Protective Packing Symbols

The protective packing symbols specify handling requirements and transport and
storage conditions.

' Fragile, handle with care

This side up

/
"?' Keep dry

o
A Environmental conditions during transport: Relative humidity
AAA (10% to 100%, including condensation)

10% — 100%
CONDENSED

+70C
Environmental conditions during transport: Temperature range (-

40 °C to +70 °C) and atmospheric pressure range (500 hPa to
—40C 1060 hPa)

500 hPa — 1060 hPa
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1.10 System Label

A sample of the system label appears below:

f/\
optevue

Optovue, Inc.
2800 Bayview Dr.

C Tested To Comply

N

Model: iVue 500
Voltage: 100-240 VAC
Frequency: 50/60 Hz
Fremont, (A 94538 USA Current: 4.0-1.6 A

ARG

with FCC Standards
Label PN: 580-49253-001 Rev. A

Fuse:
Rating: 4A/250V

Type: High Breaking
(apacity

C&o

1.11 Disposal

Dispose of the equipment per local regulations.

1.11.1 Waste Electrical and Electronic Equipment (WEEE) Recycling

Instructions
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When the device is ready for disposal, it is to be recycled according to
local (including institutional and national) policies and procedures. Do not
dispose of the device as general waste.

>

Recycling Label

This symbol is required in accordance with the Waste Electrical and
Electronic Equipment (WEEE) Directive of the European Union. The
presence of this marking on the product indicates:

1. The device was put on the European market after August 13, 2005.

2. The device is not to be disposed of via the municipal waste collection
system of any member state of the European Union. It is very
important that customers understand and follow all laws regarding
the proper decontamination and safe disposal of electrical
equipment. Instrument Description

End of section

iScan User Manual Page 30 of 181 P/N 580-49328-004 Rev. A



2 Getting Started

2.1 Unpacking the System

The iScan shipment contains the following items on arrival:

1. iScan unit 7. Small facemask

2. Motorized table (optional) 8. Dust cover

3. Mouse and keyboard 9. Lens cap

4. Power cord 10. Slot screwdriver

5. Installation manual P/N 810-49813- 11.CAM lens (optional, includes
001 Dust cover software)

6. System verification tool 12.User manual

=5 Note: The iScan system does not include a printer.

U'%?Note: The system packaging is designed so that when the upper box is
removed, component boxes can be lifted off the remaining platform.

A WARNING: The iScan unit weighs approximately 43 pounds. To lift it out of

its box, insert one hand in the front mask area and grasp the ledge above
the USB connectors at the back with the other hand. Use the proper lifting
technique: lift the scanner with your legs, not your back, and place it on the
table top. If you doubt your ability to safely lift the scanner, have another
person help you. Lifting improperly can result in injury. Dropping the
system can damage sensitive equipment.

2.2 System Setup

2.2.1 Unlock System

1. On the back of the system from the operator’s perspective is a warning label that
prompts you to unlock the system base before using. Uncover the lock point and
use the provided slot screwdriver to turn the bar %4 turn clockwise. (In this case,
clockwise is to unlock. Counterclockwise is to lock.)

2. Remove warning label and replace lock point cover.
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2.2.2 System Connections
Figure 4 shows the connectors on the right side (from the operator’s perspective).

Backup Hard Drive Cover

Ethernet port

USB Connectors (4)

Keyboard/mouse
wireless receiver

Main power Powelll' caﬁlet (to
supply switch wall outlet)

Figure 4 Connectors on Right Side

1. Plug the power cable into the back of the device and directly into a wall outlet. Do
not use an extension cord or a power strip.

2. Plug the keyboard/mouse wireless USB receiver into a USB slot.

3. Turn on the main power supply switch.

2.2.3 Start the System
1. Press the power switch below the touch screen.

2. Wait a minute while the Windows desktop opens, then double-click the iVue icon
to launch the system software.
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2.2.4 System Verification

Upon first use, scanning is disabled until you use the system verification tool to verify
that the scanner is working properly within calibration limits. (This is because the
equipment is sensitive to jarring movements that can occur during transport.) We
recommend you repeat the verification test after you transport the system to another
site, or if the system is dropped or jarred in a way that raises concern it might be

damaged.

Until you complete verification one time, a warning dialog prompts you to attach the
system verification tool when you start the system software.

7

\

pX4

Warning

Please attach systern wverification tool.
Press OK to continue

~

"y

¢ If you click OK before attaching the tool, a second dialog may appear, asking you
to make sure the system verification tool is attached.

7~

Warning

|

=)

Please make sure system wverification tool is attached.

A

Figure 5 Make Sure Verification Tool is attached

1. The verification tool has three tabs that fit in matching slots on the system lens. Fit
the tool tabs in the lens slots and, gently pressing in, turn the tool clockwise (to the
right). It stops after a little less than a quarter turn. When the tool is attached, press

OK to continue.

2. To start the verification test, go to the Tools menu and click System Verification.
The verification test begins—the system performs a test scan on the artificial eye in
the verification tool. After 10-20 seconds, the test completes and a dialog opens to
tell you whether the system verification passed or failed.
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I System verification passed.

System verification failed. Please contact Optovue custormer
v l‘\ representative at: 866-941-9240,

\

Figure 6 System Verification Passed or Failed Messages

If it passed, you can use the system normally, including scanning. If it failed, we
recommend you make sure the verification tool is properly attached—remove and
reattach it—and then repeat the test at least once again. If the verification fails twice or
more, contact Optovue customer service for assistance.

2.2.5 Language Options

The iScan system software supports Chinese, Japanese, German, French, Polish,
Spanish, Russian, Korean, Italian and Portuguese.

End of section
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3 Manage Patient Information

The system application opens by default to the PATIENT window. The application also
has a SCAN window (see chapter 4) and a REVIEW window (see chapter 5).

i o G g i g i e - -
Patient List
Basic Search t Dotasl

Thete are no tems %o show

NNV

Ethnicity:
EMRID:
Comment:

Shogl Show Todoy Thore 316 10 2ms 10 show There are o tems o shew

Show All

Add New Edit

Patient Patient Scan I?eml
pr s > > | L@

Figure 7 Patient Window

See chapter 7 for information regarding the main menu.

Use the PATIENT window to create, find, select, edit and delete patients, visits and
scans, and to initiate scanning or scan review. Features of the PATIENT window help
you enter patient information in advance, preview today’s scheduled patients, and
search for patients using a specified date range or other search criteria. The Patient list
displays search results.

3.1.1 Patient Search

To find patients in the database, you can perform a Basic Search or an Advanced
Search.

Basic Search

¢ Click Show Today to list patients scheduled for today. Click Show All to list all
patients in the database.

e To search for a patient by last name, enter the name in the Basic Search field,
make sure Last Name (default) is selected in the Search by field, and click the
Search button
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e To search by patient ID, enter the ID in the Basic Search field, use the down
arrow in the Search by field to select EMR ID (Electronic Medical Records ID),
and click the Search button.

Advanced Search

Click Advanced Search to open the Search By dialog, where you can search by the
following parameters.

o Disease e Operator

e EMRID e Physician

o First Name e Scan Type
e |ast Name e Date Range

Enter text in the fields you wish to search by and click the Search button to search with
the combination of parameters you used. If your search returns no patients or not the
ones you wish to find, reduce the number of parameters used so as to broaden your
search.

You can use the date range to find all patients with visits in the specified date range—if
you do not use any other parameters, or to find patients in the specified date range that
also match the other parameters used. Select the Specify Date checkbox to search by
date range using the From and To fields. Click the down arrow next to the From and To
fields to select dates using the calendar that appears. Use the left and right arrows on
the month to change the month.

3.1.2 Patient List

The Patient list displays results of a search. Before a search, the Patient list says
There are no items to show and the title bar says No patient selected. Click to select
a name in the Patient list. When you do:

e The selected name is highlighted in the list and appears on the title bar.

¢ The Patient Detail area shows the patient information previously entered for this
patient: Name, Gender, Birth Date, Ethnicity, EMR ID, and Comment. (To
enter or edit patient details, see sections 3.2 and 3.5.)

e The Visit list displays all visits for the selected patient by date and showing the
number of scans on that visit.

Click to select a visit in the Visit list. When you do, the Scans list displays all scans
from that visit by type icon, name, and time of scan.

Click to select a scan in the Scan list.
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Patient and Visit Shortcuts

Right-click on a Patient name or Visit date to access these options:
¢ Add Visit: Create a new visit with the current date for the selected patient.
o Delete Visit: Permanently delete the selected visit.

o Delete Patient: Permanently deletes the selected patient. A warning message
appears asking you to confirm deletion.

Warning

Deleted Patient cannot be recovered.
Do you want to continue?

[ OK ][ Cancel ]

Figure 8 Patient Deletion Warning Message

To confirm, click OK. Click Cancel to cancel deletion.

3.2 Add a New Patient

To add a new patient, click the Add Patient ;‘ button. The Add New Patient dialog
opens.

e Note: Select Patient language to change the language played by the iScan

\31

e e it e o
Required

LastName: [EETNEEN FirstName: OU ONH.GCC.Wellness. Maps Mt
Gonder: |Female

Birth Date:  01/01/1947 (MM/ddlyyyy) Audio Language:| Enghsh
Ethnecity: | Caucasian

EMR ID. Pasent Commant

Optonal

Dy Cat
Physicion isease Category

aucoma
Operator. = Fusion Study AddNew

Visit Commaont

==

‘ Scan Cancel

Figure 9 Add New Patient Screen Showing Optional Fields
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1. You must fill out the fields marked in bold. Other fields are optional. You can also
click the green arrow button at lower right to enter additional optional information.

2. When ready, click Scan to start scan capture; or click Save to save the new patient
information and return to the Patient screen; or to cancel this operation, click
Cancel to return to the Patient screen.

To add more information, click the green arrow. The Optional area of the Add New
Patient dialog appears.

3.3 Create New Visit

To create a visit for a new patient or a new visit for an existing patient, select the
desired patient in the Patient list and click the Scan button. The system creates a new
visit with today’s date and the SCAN window opens. Select the desired scan type to
select the desired series of scans. To add more Visit information right click on the main
patient screen visit window and select the Add Visit option.

3.4 Change Date of Birth Format

It is recommended that all patients be linked to a unique identifier, such as their date of
birth. You can set the default format for date of birth in the User Preference dialog:

s

User Preference [>)
Allow Save Eye Blink Data Yes v

| Archive Drive -
Secondary Archive Drive: -
Scan Auto Save:
Primary backup drive: M I
Secondary Backup Drive:
Refina Map Default Display Map: NDB Reference Map -

| Retina Cross Line Default Display: Both -
¥| Auto saving PNG

PNG directory: C:\Eyepacs
J l OK Cancel

Figure 10 User Preference Dialog
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[15' "Note: The iVue computer settings must match the date format specified above.

To change the computer date settings:
1. Go to Regional and Language Options in the control panel.
2. Click the Customize button under the Regional Options tab.
3. Select Short Date Format under the Date field. Click the OK button to finish.
4

. Restart the iScan application after changing the date format.

3.5 Edit Patient or Visit Information

To edit a patient’s information, select the patient name from the menu and click
the Edit button.

3.6 Patient List Shortcuts

Click on the patient’s name to view patient visits. Right click on the patient name or visit
date to view options:

e Add New Visit: Create a new visit with the current date for the selected patient.
This takes the system directly to the SCAN window (see chapter 4).

e Delete Current Visit: Deletes the selected visit.

o Delete Current Patient: Deletes the selected patient. A warning dialog notifies
you that you cannot recover the deleted patient.

Warning

Deleted Patient cannot be recovered.
Do you want ko continue?

[ OK ]L Cancel ]

Figure 11 Delete Patient Warning Message

Click OK to confirm Patient deletion, or Cancel to cancel deletion.

3.6.1 Review Button and Scan Button

After selecting a patient, click the Review button to review that patient’s scans
‘ (see chapter 5).

After selecting a scan in the PATIENT window, you can click the Scan button to
4 switch to the SCAN window and repeat the selected scan.
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End of section
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4 Capture Scans
The SCAN window is where you capture scans.

ST
.=

Note: Placing the mouse over the icon will display the
scan name.

—

- Nerve Fiber ONH

OCT Image Area

L. LD Nerve

Fiber

®aaBE
A
+ 03 o

Cornea @ 4 d( (€N
&y Semcr | ON |

Figure 12 SCAN Window

L) oD
@ os

Retina

Figure 12 Legend

1. OU (Both Eyes) Button
2. OD (Right Eye) Button
3. OS (Left Eye) Button

iScan User Manual

. Eye Sensor on/off Toggle

4
5. Scan Protocol Buttons (3 Rows)
6. iWellness Button

7

. Start Button
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Nerve Fiber Protocol: GCC — ONH — 3D Disc,3D Neve A8 &
Fundus Enface Fiber O A 5 22

Retina Protocol: Cross Line — Retina Map — 3D ~
Retina ram | =~ | [ | 25
Cornea Protocol: Pachymetry- Angle- Lens fitting Cornea < |4

4.1 Scan Capture Instructions
Follow these steps to capture scans.

1. In the PATIENT window, find and select the desired patient, or if the patient has
not yet been added to the system, add the patient now. See chapter 3 for
instructions.

2. Make sure to clean the face mask surfaces before asking the patient to place their
face in the facemask. Use an isopropyl alcohol wipe or a germicide with a clean
lint-free cloth. Section 8.2.1 has these cleaning instructions.

ﬂ‘%?‘Note: You can also use a disposable biological barrier over the facemask.
Paper barrier sheets designed for use with the iScan system are available
from Optovue.

U{E’?Note: Insert the small mask if the patient’s head size is in the smallest one third
of the normal population. You can also try the small mask if the system
cannot find the correct working distance. Use the facemask for all cornea
scans.

3. When you have selected the desired patient, click the Scan button to switch to the
SCAN window.

4. In the SCAN window, the OU button is selected by default (see Figure 12 above.
Select the corresponding button if you will scan only the right or left eye. The eye
selected appears below the video image at upper left.

5. Select the desired scan protocol or scan from the three rows of icons.
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Nerve Fiber Protocol: GCC — ONH — 3D Disc3D
Fundus Enface,

Nerve
Fiber

DB E

Retina Protocol: Cross Line — Retina Map — 3D
Retina

Retina

+ /B S

Cornea Protocol: Pachymetry- Angle-Lens Fitting

Cornea

p—

& < J

=5 Note: If you select a cornea scan, attach the CAM lens before scanning. See

section 4.1.1 below.

6. Click the green Start button . The scan process begins. In the default software-
assisted mode, the system begins to give audio commands and proceeds through
the scan process to scan capture. Attend to the process and assist as necessary.
Proceed to section 4.2 to follow the automated process and understand what

assistance may be required.

4.1.1 CAM Lens

The iScan cornea adaptor module, also known as the CAM lens or cornea lens, is
required for corneal scans. It is not interchangeable with other iVue detachable lenses.
It is unique to the iScan system and is distinguishable by six LEDs (that shine red when

the lens is attached properly—see Figure 15).

—

o/

Bottom View

Topﬁw

Figure 13 CAM Lens Unnattached
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When you select a cornea scan, the system automatically advances the lens so you can
attach the CAM lens. Figure 14 shows the system lens in the home position and
advanced position.

Home position Advanced position

Figure 14 System Lens Advances to Attach CAM Lens

1. The CAM lens has tabs that fit in matching slots on the system lens. Fit the CAM
lens tabs in the system lens slots and, gently pressing in, turn the tool clockwise (to
the right). It stops after a little less than a quarter turn. The six LED lights illuminate
when the lens is properly attached. Figure 15 shows the CAM lens attached.

Attached CAM lens

Figure 15 CAM Lens Attached

4.1.2 Queuing Multiple Scans

Select the buttons of all the scans you wish to perform. The system performs individual
scans by the eye and in the order you select them. The scan buttons are listed in the
recommended order for each protocol (Nerve Fiber, Retina, Cornea rows).
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4.1.3 Audio Commands

Before and during the scan, the system gives audio commands and shows on-screen
messages to assist you and the patient as necessary. For example, if the patient’s head
is not properly seated in the mask, the message below appears. The patient’s language
can be selected when the patient information is entered or by using edit.

7 —

5 n|
Warning ‘ &l

Please make sure forehead is against the headrest.

A — v,

Figure 16 Make Sure Forehead Is Against Headrest Message

Most audio commands direct the patient in positioning their head or eye. The table
below lists the audio commands the system uses.
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Audio Commands

Audio Command

Notes

Place your head into the middle of the mask. Your
eyes should be level with the yellow lights.

Assist patient to put face in facemask.
Enter patient information as necessary.

Please look at the center of the green fixation target.

Central fixation, used in all retinal scans

Please look at the green fixation target to the left of
center.

For right eye disc scans (GCC, ONH, & 3D
Disc).

Please look at the green fixation target to the right of
center.

For left eye disc scans (GCC, ONH, & 3D
Disc).

Operator: Please adjust patient’s head.

When system cannot detect eye.

Aligning to your eye.

System aligns to the eye.

Adjusting to your eye.

System adjusts focus, polarization.

Auto mode has been paused.

Operator pauses scan.

Please blink. Then keep your eye open.

Restore tear film before capture.

Corneal Commands Only

Please sit back while the cornea lens is attached

Before cornea scans.

Please look at the yellow light to your right

Position right eye for cornea scan.

Please sit back while the cornea lens moves to the
other eye.

Rest between eyes.

Please look at the yellow light to your left.

Position left eye for cornea scan.

Please close your eyes.

Rest eyes after or between scans.

Scan is complete; please sit back.

Procedure done.

Operator Commands Only

Please place your head against the mask.

System cannot detect forehead against
facemask.

Operator: Please adjust patient’s head.

System detects forehead, but cannot
detect eye.

4.2 Auto Alignment

Follow these steps during auto alignment (in software-assisted mode) and assist as

necessary.

1. The system finds the eye and advances. The camera shifts from far to near
camera (see section 4.2.1). If the eye is not visible in the video image, the system
cannot find the eye. Reposition the patient so the eye is visible with the pupil
centered as shown below. The slider to the right of the plus and minus arrows

indicates the camera position.
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Eye: Right/OD Sean Reting Cross Lir

Offsot

Figure 17 Scan Alignment in Progress

2. If the eye is visible in the video image but the system fails to acquire the image,
click the center of the pupil or use the four green arrows to align the eye in the
center as shown above.

U';E%’Note: The camera has reached its limit if an arrow turns gray. In this case,
reposition the patient as necessary.

3. When the auto eye sensor is on, the system identifies the eye based on the
scanner position. If the patient’s head is improperly positioned to acquire a scan,
turn off the auto eye sensor.

To provide ease of use when performing a variety of scans on the same eye for a
patient, the system remembers the last eye selection for a visit on that patient. At any
point, if you leave the SCAN window (to review a captured scan, for example), you must
select the eye again, since both Right/OD and Left/OS buttons will be deselected and
disabled.

[1"‘3‘-_’}_'1Note: There are a number of conditions which would render measurements
unreliable, for example: the inability of subjects to maintain fixation; strong

nystagmus; and dense media opacities. Myelinated nerve fibers could affect
the RNFL thickness results adversely.
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4.2.1 Software-Assisted Alignment, Far and Near Cameras

In software-assisted mode, during alignment, the system uses two cameras, far and
near. It begins with the far camera (whole eye) as it moves forward to find the pupil and
then the retina, aligning as it goes. At a certain distance from the eye, it switches to the
near camera (iris and pupil). If the patient is out of range, the system asks that the
patient be repositioned. Use the manual alignment controls to assist as necessary. See
the tips in the following paragraphs. For details, see section 4.5.

/ \ @ o los
[5] oo e ot 0o o
(:'.:;.‘1:‘. \ E Nerve Foer 30 Duc 0 o

>I:yU

N [E]r
O P,
4
J
Eye Align Auto Adjust Capture % .:—-...

EfE{

Cataract

Figure 18 Manual Alignment Controls

The IR real-time video in the top left-hand corner shows the system searching for the
reflection of the projected dots when in far camera mode. As the system moves forward,
the pupil should be centered and the iris in focus. (Note that the B-scan image at top
center and live en face image at lower left may not be visible yet).

System centering
pupil in window

Eye: Right/OD Scan: Retina Cross Lis

Figure 19 Scan Alignment and Adjustment in Progress

When the pupil is centered, guide the patient to open the eyes as wide as possible. You
should see three dots of reflected light in the video image.
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If the system seems unable to find the eye center, touch the pupil center in the live
video image and the unit corrects for the appropriate distance. The system then
advances to the correct working distance.

4.3 Auto Adjustment

Once auto alignment is complete, the system starts auto adjustment, in which the
system automatically adjusts focus and polarization to optimize signal strength. A
System Status dialog appears with the message Auto Adjust in progress. Please wait
.... and includes a progress bar. The Reset/Offset button disappears and the Reset
button is enabled.

Fye Fght /OO Scan Nerve Fiber GCC

O Awvadunmpogess Posse mat

Figure 20 Auto-Adjustment In Progress

ﬂ'{‘?Note: If the system cannot achieve adequate signal strength after it attempts
auto adjustment three times, it asks for manual assistance.
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When auto adjustment is complete, the dialog disappears. If the scan is ready for
capture, the en face image appears at lower left.

-
Tfii

AIEEEEEE

Figure 21 Auto-Adjustment Complete

4.4 Automatic Capture

When the camera is in position, the system audio asks the patient to blink and hold their
eye open. Then the system automatically captures the scan and continues to the next
scan. During scan capture, the B-scans appear at top center and a System Status
dialog displays a progress bar.

Processing data. please wait

66% completed

Figure 22 Progress Bar

Once the scan is captured and saved, the system proceeds to the next scan in
software-assisted mode, until all scans are completed.
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4.5 Manual Scan Controls

The scan controls are present during the scanning process. Use them to make manual

adjustments during software-assisted mode, o

r to capture scans in manual mode.

' Uk
@ «—2

Eye Distance 6
Opacity i
Eye Align Auto Adjust<€—5 9

Scans menu

8
Nerve Fber ONH
7 Narve Fber 30 Disc

E Nerve Fber GCC
D Retna Mo
[I] Retna Cross Line
[ rere

J

[3 Comea Pachymetsy

Z Comea Angle

E] Welress

Capture

Figure 23 Scan Controls

Figure 23 Legend

1. Center Pupil Green Arrows: Up, Down,
Right, Left

2. Eye Distance: Forward button (+), back
button (-)

3. Opacity checkbox
4. Eye Align button
5. Auto Adjust button

4.5.1 Manual Mode On/Off

6. Resume/Pause button (Pause
shown)

7. Stop button

8. Manual scan adjustment (cog
icon)

9. Capture button

The MANUAL on/off button is below the video image. The button is off by default, so
the system uses software-assisted mode by default. If the system cannot find the eye,
click to toggle manual mode on, then use the green arrow buttons to align manually.

MANUAL

off

Figure 24 Manual

on/off Button
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=5 'Note: For all anterior (CAM) scans, you must use manual mode; software-
assisted mode is not available.

Center Pupil Arrows
The four green Center Pupil arrows move the image up, down, left, and right.

Eye Distance Arrows and Slider

The two green Eye Distance 3D arrows move the scanner forward (+) and backward
(-). The Eye Distance slider shows the scanner position relative to its range. You can
drag the slider to move the scanner too. Use caution to avoid contacting the eye.

Pausing and Canceling

You can pause or cancel the scan process at any time. Click the yellow pause button to
pause, and the button changes to a green start (resume). If a progress bar is active, use
the ESC key on the keyboard to interrupt the system. The system pauses at the end of
the task.

o

Green
Resume

{ Button Red Stop
Button

Ere Mgt/ G0 Beam Hetnn Cres Line e
Jhe

|

g 1

Figure 25 System Paused, Green Resume Button Visible
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To cancel a scan, press the red X button. A Cancel Options dialog appears.

Please select one of the following action:

‘ Cancel the current scan ‘

Cancel all scans

Figure 26 Cancel Options Dialog

The options are:

e Cancel the current scan: Cancels the current scan and proceeds to the next
queued scan.

¢ Cancel all scans: Cancels all queued scans and returns to the SCAN window.

e Close: Closes the dialog and proceeds with the current scan.

4.5.2 Making Manual Adjustments

In manual mode, the Center Pupil and Eye Distance green arrows and slider are
enabled.

VN

\
Center |
| Pupil Eye Distance
|

Cataracl \ }

Eye Align . Auto Adjust Capture

Figure 27 Center Pupil and Eye Distance Arrows
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e To center the pupil in the video image at upper left, use the Center Pupil arrows
or click the pupil center. You can also click the Eye Align button to have the
scanner attempt to align automatically.

o After centering, use the green Eye Distance arrows to move the scanner forward
(+) or backward (=) until the iris is in focus in the video image, for retinal scans.
For corneal scans, move forward until the OCT image of the cornea is between
the red lines.

e [f an arrow is disabled (gray), it means that the scanner cannot go further in that
direction and you should reposition the patient. After repositioning, check with the
patient to confirm that the fixation target and scan pattern appear in the proper
location. The fixation patterns for all scans are found in section 9.3.

e Once the pupil is centered and the iris is in focus, click the Auto Adjust button to
find and enhance the OCT image. To manually adjust the OCT image, select
Manual Scan Adjustment.

e When you see an OCT image of sufficient quality, click the Capture button. The
system automatically saves the scan and the Completed Scans list updates.
After capture, you have four options:
¢ Click Scan Again to take another of the same scan type,
¢ Click Stop and select one of the cancel options,
e Click the REVIEW tab to analyze scans already captured, or
e Click the PATIENT tab to return to the PATIENT window.

4.6 Scan Capture Instructions for Certain Scan Types
The following instructions can help you capture good scans for these scan types.

4.6.1 Optic Nerve Head (ONH) Scans

For optic nerve head (ONH) scans, if the system is in manual mode, or if the software-
assisted mode is having difficulty, click the center of the optic disc on the live en face
image after auto-adjusting. The optic disc should then appear in the center of the circle
on the en face image. If the system is in software-assisted mode, it continues; if in
manual mode, then you can capture the scan. The system then asks to capture a 3D
Disc scan as an ONH reference. Center the optic nerve for the 3D reference scan as
before.
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4.6.2 Cornea Angle Scans In Manual Mode
You can capture Cornea Angle scans only with manual alignment. Follow these steps:

1. Attach the CAM lens.

2. Use the external fixation lights at the sides of the facemask to guide the patient’s
fixation. Similar to the Retina Cross Line scan, you can rotate the Angle scan up to
90°, both clockwise and counterclockwise, in five degree intervals. To rotate the
scan, move the mouse pointer to the video image and scroll the mouse wheel. The
arrow on the video image shows the location and orientation of the scan. Touch
the IR screen or use the four Center pupil arrows to position the scan line over the
limbus of the eye with the arrow pointing to the center of the pupil.

3. Try to ensure the cornea scleral plane is as flat as possible, that is, perpendicular
to the scan.

4. The fixation light turns on automatically for OD or OS.

NVIS

Eye. Right/ 0D Scan: Cornea Angle

; manvaL. ON

Cataract J

Eye Align Next Scan Scan Again

Figure 28 Corneal Angle Scan Sample

5. Advance using the plus arrow until the surface of the cornea/sclera touches the
upper red line.
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The Angle scan can also be used to visualize the landing zones of lenses, nasal,
temporal, inferior and superior. The Angle scan line should be perpendicular to the
plane where the lens contacts the sclera. Four images can be selected to display on a
single page. . You can rotate this scan in 5° intervals up to 90° clockwise or
counterclockwise. To do so, move the pointer over the video image (upper left) and
scroll the mouse wheel.

Figure 29 Landing Zones

4.6.3 Pachymetry Scans in Manual Mode

You can capture pachymetry scans only with manual alignment. When you initiate a
pachymetry scan, a warning dialog prompts you Please make sure the correct CAM
lens is attached.

l Please make sure the comrect CAM lens is attached.

Figure 30 Make Sure CAM Lens Is Attached

1. Attach the CAM lens if not already attached. Click OK to proceed.

2. Use the four green directional arrows to center the pupil in the video image at
upper left, using the two green concentric circles as a guide. Move the scan
forward using the green 3D colored arrows until the OCT image of the cornea is
between the red lines, as shown below.
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Figure 31 Use Distance Arrows to Place Cornea Image between Red Lines

3. Click Capture to capture the scan. When the scan completes, click Scan Again or
Next Scan to capture another scan.
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4.6.4 Lens Fitting Scan

The Lens Fitting scan is taken similar to the pachymetry scan. Attach the CAM lens
before scanning. Center the video image (upper left) on the pupil and move the scanner
forward slowly. As you move forward, the iris comes into focus and the top of the scleral
lens appears in the OCT image. Continue forward until the top and bottom surfaces of
the scleral lens and the cornea are visible in the OCT image. Auto-adjust and capture.

Note: the top surface of the scleral lens must be visible in the OCT window for the
algorithm to detect the vault/clearance. Also the index of refraction must be entered to
complete analysis.
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End of section
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5 Review and Edit Scans

The REVIEW window is where you review scan reports. Each type of scan report has its
own elements and layout in the REVIEW window. An example is shown below.

Retina Map Scan Quality Index [JESSEIEEN O View Reproducibility Left/ OS

ETDRS grid

[ Print [ change anatysis | [ Commen

Figure 32 Example Review Window—Retina Map Scan

The REVIEW window opens when you double-click on any saved scan, or when you
click the REVIEW tab. The left side of the REVIEW window includes Patient, Visit and
Scan lists. At bottom left is a set of Tools.

5.1 Scan Registration for Comparison

In some reports, you can compare multiple scans of the same type over time. To enable
accurate comparison, these multiple scans must be accurately aligned, or registered,
with each other. The system uses a baseline scan, also called a reference scan, for
registration of multiple scans. Specifically, it uses for registration particular features,
such as blood vessels or the fovea, in the SLO-like image. The ONH scan uses the
SLO-like image of the 3D Disc scan as baseline for registration.

Registration of multiple scans enables clinicians to compare scans over time and
thereby track progression of retinal diseases and glaucoma. When multiple scans of
eligible scan types have been acquired, the Change Analysis or Comparison button is
present on the scan report.
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Retinal morphology can change over time due to disease progression or surgery. In
such cases, the clinician can acquire a new baseline scan. Subsequent scans from that
point use the new baseline scan. Scans prior to the new baseline scan continue to be
registered against their original baseline scan.

5.1.1 3D Disc Scan for ONH Registration

The system uses the SLO-like image of the 3D Disc scan as baseline for registration of
ONH scans. Specifically, it uses the disc margin, disc center and vessels for
registration. It finds the disc center by first tracing the disc boundary (disc margin) on
the 3D Disc scan image. If you acquire an ONH scan before the 3D Disc scan for that
eye, the system prompts you to capture the 3D Disc scan in the Baseline Disc Boundary
dialog.

5.2 Scan Quality Index

The Scan Quality Index (SQI) appears at the top of the screen for all scan types. The
SQlI can be either Good and highlighted green, or Poor and highlighted red. It includes
a numeric value. The system quantifies the average intensity of reflected light over the
whole scan pattern to determine the SQI from 1 to 100: the greater the intensity
(brightness), the higher the SQI. When the SQI is at or above the cutoff value, it is
labeled Good, and you can continue. When the SQl is below the cutoff value, it is
labeled Poor, and you should retake the scan. If after retaking, the scan does not
improve to Good, for example due to media opacity, we recommend caution in
interpreting its results.

A Good SQI indicates that ocular structures and layers are generally visible and easily
segmented. A Poor SQI indicates that ocular structures and layers may not be
generally visible and easily segmented. The table below shows the SQI cutoff value for
each type of scan.

Minimum Recommended SQl for Each Scan Type

S]] Minimum Recommended SQlI
Retina scans 40
ONH scans 27
GCC scans 32
Cornea scans 27
iWellness scan 40

SQl is Good for most patients in normal use. However, the light absorption properties of
pathologies can make it difficult to achieve a Good SQl. If SQI is not Good over a
range of patients including those without pathologies, contact Optovue Technical
Support for assistance. For detailed information regarding the usability scans with a
Poor SQl, see the relevant Appendix.
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5.2.1 Factors Affecting Scan Image Quality

In addition to the SQI, other factors can affect scan image quality. Consider all factors;
do not rely on any one factor when judging image quality.

1. SQI: The system quantifies the average intensity of reflected light over the whole
scan pattern to determine the SQI from 1 to 100: the greater the intensity
(brightness), the higher the SQI. When the SQl is at or above the cutoff value, it is
labeled Good, and you can continue. When the SQI is below the cutoff value, it is
labeled Poor, and you should retake the scan. If the scan does not improve to
Good, for example due to media opacity, we recommend caution in interpreting its
results.

2. Locally weak signal: An area of locally weak signal in an OCT image is a place
where you cannot see retinal layers. Such areas may be due to blinks, eye lid
occlusion, poor alignment, or other reasons. Since the software does not measure
thickness at the right and left edges of the OCT image, locally weak signal at the
edges can be disregarded and measurement results are not affected. When areas of
weak signal are within the measurement area, that is, not near the right or left edges
of the OCT image, measurements in these areas may not be accurate and you
should retake the scan. Keep in mind that a scan can have a Good SQI while having
areas of weak signal, and still should be retaken because weak signal areas are
within the measurement area.

3. OCT data out of bounds: For some scans, the OCT data might be out of the OCT
window boundary (that is, data is clipped off because the OCT data is either too high
or too low in the OCT window). If this happens at the edge of the scan region, it is
not likely to have a negative effect on the final measurements. However, if it exists
inside the measurement area, the results can be affected and the scan should be
retaken.

iScan User Manual Page 61 of 181 P/N 580-49328-004 Rev. A



5.3 Tool Pane

The icons in the Tool pane at bottom left provide tools for measuring, annotation and
scan presentation.

Invert OCT

Image Save Report Export as

Darken Brighten as JPG PNG

B (o] i [
\ -
T e A

Distance Line Angle

Color/Gray

View B-scans

Figure 33 Review Screen Tools

e View B-scans: Opens the B-scan window. You must open the B-scan window to
modify the segmentation boundary lines (see section 4.5.2 or to use the following
four tools.

¢ Distance: Select to measure the distance between two points you place
on a B-scan.

e Line: Select to draw a line on a B-scan.

e Angle: Select to measures the angle you draw. Click on the OCT image to
place the angle vertex. A line follows the pointer until you click to make the
endpoints of the two lines that form the angle. The measurement appears
inside.

¢ Annotate: Select to annotate the B-scan.
o Color/Gray Scale: Toggles scan display between pseudo-color and gray scale.
o Invert: Inverts black and white in a grayscale image.
¢ OCT noise: Increase (white) and reduce (gray) OCT noise level.

¢ Save Report as JPG: Saves the report as an image in JPG format. The default
filename created combines patient and scan information, but you can edit it. You
can select the destination folder.

e Export as PNG: Saves the report page in .PNG format. The filename has a
default combination of patient information, but you can edit it. You can select the
destination folder

End of section
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6 Scan Reports

6.1 Retina Map Report

The Retina Map report shows the 6 mm x 6 mm retina map with an ETDRS grid and its
associated thickness values, along with an en face image from the scanning session.
Seven scan images (each an average of five scans along that raster line) appear at
lower right. The currently selected scan appears in the large image at the top. Click or
scroll to select a different scan for larger display. The system applies the default Auto
Zoom function to the large OCT image at the top. To see the large image without Auto
Zoom, uncheck the Auto Zoom checkbox to the right of the image.

Retina Map Scan Quality Index [JGEBENENN [ View Reproducibility Right / OD

M
L
S
)
P\ 25]
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P 4 hickness x B e
T d @ Full Retinal ol i o
i/ e Retina
v © Outer Retinal
e ! NDB Reference 7
o O Full Retinal % 8 i o
§ 6\, 3; SR o ———
Y

oplevue
Figure 34 Retina Map Default View

At bottom left, the en face image is overlaid with a thickness map by default. In the
Thickness box to the left of the scan images, you can select either Full Retinal, Inner
Retinal or Outer Retinal thickness for display. When you select the Full Retinal radio
button in the NDB Reference box, the overlay becomes an NDB (normative database)
reference map. Note that the normative database applies only to full retinal thickness.
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In the default Retina Map report, the View Reproducibility checkbox is not selected.
Select the View Reproducibility checkbox to show the calculated range of

reproducibility for each thickness parameter.

checked. Parameters

Retina Ma . . Index [HEEEE [ View Reproducibility
View Reproducibility / ’

Right/ OD
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Para * (m) 293 (13.5%) 300 (26.0%)
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Figure 35 Retina Map, View Reproducibility Checked

6.1.1 NDB References

NDB references are available only for full retinal thickness.

NDB references can appear in the ETDRS Chart (center), the NDB Reference Map
(lower left) and the retinal parameters table (when View Reproducibility is selected).
The NDB color key explains that green is within normal thickness (p-value between 5%
and 95%); yellow is borderline too thick (p-value between 95% and 99%); red is greater
than normal thickness (p-value >99%); blue is borderline too thin (p-value between 5%
and 1%); and dark blue is less than normal thickness (p-value <1%). See Appendix B

for more detail on the Normative Database.

=5  Note: The normative database embedded in system software enables
comparison of measured retinal thickness with that of patients in the
normative database. NDB comparison provides an objective metric for a
clinician to use in making an overall diagnosis.

ﬂ'%‘Note: The ETDRS chart in the center reflects 1, 3, and 5 mm diameter zones
instead of the 1, 3, and 6 mm diameter zones in the traditional ETDRS chart.
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Manual Boundary Adjustment: This feature enables you to review and manually
adjust segmentation boundary lines applied by the software. To adjust boundary lines
manually, click the View B-scans button on the Tool menu, or select Modify Boundary
from the OCT Image menu. Adjust the segmentation boundaries and click Save.
Manual boundary adjustments trigger recalculation of measurements when you click
Save.

0=5 Note: Any modification to the segmentation lines erases any prior annotations
on the report. If you wish, restore any annotations after modifying the
segmentation.

=5 Note: The Clean Diagnosis Data function does not affect manually edited
scans.

Thickness and NDB Reference: This feature selects the designated retina map
display. Thickness metrics of the selected layers or the percentile relating to the
Normative Database (Full Thickness) and RPE elevation measurements for the full
retina and other measurements are:

¢ Full Retinal — Segmentation from ILM to RPE
¢ Inner Retinal — Segmentation from ILM to outer limit of IPL.

e Outer Retinal — Segmentation from IPL to RPE

Factors that can affect the segmentation or thickness map results:

Check the layer segmentation accuracy of the retina scan: The segmented
layers for retina scans are the ILM (Inner Limiting Membrane), IPL (Inner Plexiform
Layer), and RPE (Retinal Pigment Epithelium). Check the segmentation lines for
accuracy and make adjustments as necessary. The ILM segmentation line should be
at the retinal surface at the ILM. The IPL segmentation line should be at the outer
limit of the IPL layer. The RPE segmentation line should be in the middle of the RPE
layer. Inaccurate placement of the segmentation lines affects the resulting thickness
measurements. If you perform any manual correction, the results will be valid and
the scan can be used.

Fovea locator: Software automatically identifies fovea location for EMMS5 scans,
primarily based on detecting the thinnest location of the inner retinal thickness. To
compare EMM5 scans from different visits, the software uses the fovea location as
the basis for registration. The fovea location detection should be verified by user for
individual EMM5 scans. The fovea location can be easily verified by switching to the
inner retinal thickness map display. If the fovea is off center to a large degree
relative to the ETDRS grid, it should be manually corrected. The automatic fovea
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find may be affected by retinal pathologies and fixation error. If a patient failed to
fixate on the fixation target or near the target, the actual fovea could be outside the
software search range and thus result in an incorrect fovea location.

Retina scan pattern not centered on the fovea: During the retina scan, if the
patient does not maintain good fixation, the fovea may not be in the center of the
scan pattern. All measurements assume the fovea is in the center of the scan within
500 microns. If it is not, then the measurements will be affected.

If the fovea is not in the center of the scan, you can move it manually. This
ensures the measurements come from the expected locations. If the repositioned
fovea causes some measurement areas to be outside the scan pattern, these
measurements should not be used. Select either Full Retina or Inner Retina
thickness button to further visualize the foveal depression. The fovea position
marker (yellow dot) can be moved on the scan by simply dragging and dropping the
yellow dot, and selecting Yes at the prompt to reprocess. The reproducibility chart
changes to reflect the new values.
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ETDRS Centering On Fovea
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6.1.2 Retina Map OU Report

Retina Map OU Report
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Figure 36 Retina OU Report

Retina OU report shows a Bscan and either Thickness or NDB Map from each eye. Map
layer is selectable, Full, Inner, Outer

6.1.3 Retina Map Change Report

Retina Map Change Analysis Left/ OS
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Figure 37 Retina Map Change Analysis Report
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Retina Map Change reports display the previous scan at the top and the current scan at
the bottom. The en face image includes a thickness map. The current map can display
the change from a previous scan, or the actual thickness values of the scan result.
Retina scans from different scan times are aligned according to the location of the
fovea, which can be manually adjusted.

Each of the seven current raster scans is displayed with the same scan of the previous
Retina Map scan. (User selected if more than one previous visit or scan.) Scroll the
mouse wheel to move through the available seven raster scans.

D=5 Note: The Clean Diagnosis Data function does not affect manually edited
scans.

ﬂ'{‘?Note: Clicking the OU Report redisplays the original screen at any pointing the
process.

Change analysis is a simple difference map without any statistical adjustments. The
values are simple differences and may not be statistically or clinically significant.

If scans in multiple visits were manually adjusted, make sure the foveal adjustments are
consistent.
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6.1.4 Retina Cross Line Report

The default screen of the Retina Cross Line report shows one or two OCT images
(option Both selected as shown below), and the en face image. An arrow in the top right
corner of each OCT image indicates the scan direction. Arrows on the en face image
show the direction and location of the scan.

0= Note: You can choose the default display from User Preference (See section
7.2.1 for more information).
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Figure 38 Retina Cross Line Report with Both Selected

The Both radio button (default) displays both scans, as shown above. Select the #1 or
#2 radio button to see each single scan image in a larger display area, as shown in the
image below. Again, the scan direction arrow in the top right corner illustrates the scan’s
correlation with the arrow on the en face image.

iScan User Manual

Page 70 of 181 P/N 580-49328-004 Rev. A



i Bl Took OCTImage Database Management Home Help

Semple, Patient

N3V

El Visi
£ T osi2010 105cans

. 1
e

E = 05/2172010
m 0D Retina Cross Line 10:53:35

g 0D Retina Map 11:00:27
‘:] 0S RetinaMap 11:01:29

0S Retina Cross Line 11:02:18
0D ComeaAngle 11:03:42
0S ComeaAngle 11:05:08
0S Comea Angle 11:0553

| Retina Cross Line Scen Qualiy Index [ EESEI

Comment | Opf.‘vue

= |
VEED
e o —CT— [ovma ]

Right / OD

Figure 39 Retina Cross Line Report with #1 Selected

Retina Cross Line OU Report

When Retina Cross Line scans have been taken for both eyes, the OU Report button is
available. Click it open the Retinal Cross Line OU Report, which shows both scan

images by default (Both radio button selected).
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Figure 40 Retina Cross Line OU Report
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Select #1 or #2 to show that scan in a larger display, as shown below.
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Figure 41 Retina Cross Line OU Report with Option #1 Selected

6.1.5 Retina 3D Report
A Retina 3D report appears below.

Ret|na 3D Scan Quality Index | Good 82 R|ghtll OD

6,00 6.00 Scan Size (mm)
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3D Display

V| show Bnd
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Figure 42 Retina 3D Report, Thickness Tab Selected

iScan User Manual Page 72 of 181 P/N 580-49328-004 Rev. A



The image at upper left has three tabs which present different viewing options:

SLO: Shows an SLO-like image created by the sum of all C-scans, producing a
high contrast en face image.

En Face: Shows the sum of C-scan planes indicated in the thickness value field.
In this view, you can select from the ILM, IPL, and RPE radio buttons to view
three different reference planes.

Thickness: Shows retinal thickness using a color log scale. You can select from
the Full, Inner and Outer radio buttons to view thickness in these retinal
segment.

The lower panel and top right panel are the currently selected horizontal and vertical B-
scans respectively, which correspond with the green (horizontal) and red (vertical) lines
on the upper left image. Click anywhere (or use the sliders) on the upper left image to

change the currently selected B-scans.

Click the 3D Display button at lower right to open the 3D display.

iScan User Manual
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Figure 43 3D Retina Display

Click a radio button at right to access the optional 3D views: SLO 3D, Full
Thickness, Inner Thickness or Outer Thickness.

Click and drag the 3D image to change its orientation. The eyeball at lower right
moves in sync with the 3D image, and the red letters on the eyeball—T
(temporal), S (superior), N (nasal) and | (inferior)—help you recognize the
orientation.
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e Click the 3D image and scroll with the mouse wheel to zoom the image in and
out.

e Click Reset View to return to the default position.

6.2 Nerve Fiber ONH Report

The Nerve Fiber ONH report provides maps, a TSNIT chart and tables to enable
qualitative and quantitative assessment of the retinal nerve fiber layer (RNFL) and the
optic disc. All NDB software includes the basic 3D optic nerve scan for ONH scan
registration. The full featured scan is available as an upgrade.
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Figure 44 Nerve Fiber ONH Report

6.2.1 RNFL and ONH Analysis Table

At middle right is the RNFL and ONH Analysis table, which reports average RNFL
thickness values on the left, and ONH analysis values on the right. Cell coloring reflects
comparison of each value with the normative database. As the legend at bottom center
shows, applicable measurement values are color-coded to show where measurements
are within normal (green, p-value > 5%), borderline (yellow, p-value between 1% and
5%) or outside normal (red, p-value < 1%).
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6.2.2 TSNIT RNFL Thickness Graph

200

100

T S N I T
Figure 45 TSNIT RNFL Thickness Graph

At top right is a graph with the black line depicting RNFL thickness (in pm) along a
calculated 3.4 mm diameter circle centered on the optic nerve head. The red, yellow
and green background on the graph represents the normative distribution of RNFL
thickness, enabling you to see the measured RNFL thickness relative to normal.

ﬂ% Note: RNFL thickness is calculated at 3.45 mm diameter around the detected
center of the disc, not the center of the scan. If the disc was not centered
relative to the scan beam it does not affect the measurement.
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6.2.3 RNFL Thickness Map

At lower right is a color-coded RNFL thickness map of 5 mm diameter. Warmer colors
from yellow, orange and red to white represent increasing thickness. Cooler colors from
green to blue to black represent decreasing thickness. Disc margin (green line) and cup
margin (red line) are traced at the center of the map. The space between the cup and
disc margins is the rim area.

RNFL measurement location
(black line at 3.4 mm diameter) [,

TU

|

\\\ Cup margin (green line)

Average thickness in
this sector

p<5% Borderline .
-

_ T T IN
Figure 46 RNFL Thickness Map

Average RNFL thickness for each of eight sectors appears in a ring at the outer edge of
the map. Each measurement appears against a green, yellow or red background,
indicating whether the measurement is within normal (green), borderline (yellow) or
outside normal (red). The RNFL thickness measurement at 3.4 mm diameter is sampled
relative to the disc center, not the scan beam center, so minor de-centering of the disc
relative to the scan beam does not affect the measurement.

6.2.4 Hemisphere and Quadrant Maps

)

| |
Figure 47 Hemisphere and Quadrant Maps
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The hemisphere and quadrant maps show average RNFL thickness in the indicated
hemispheres (left) and quadrants (right). Each measurement appears against a green,
yellow or red background, indicating whether the measurement is within normal (green),
borderline (yellow) or outside normal (red).

Select the View Reproducibility checkbox to show the calculated range of
reproducibility for each thickness parameter. (The system calculates the reproducibility
range of the TSNIT graph based on the measured thickness result + 2 x
[Reproducibility], where reproducibility is the standard deviation of reproducibility
estimated from the iVue Reproducibility and Repeatability study—see section 11.2).
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Figure 48 Nerve Fiber ONH Report Showing Reproducibility Parameter Values

6.2.5 ONH Manual Boundary Adjustment

This feature enables you to review and manually adjust the RNFL boundary lines
applied by the software.

1. To manually adjust the RNFL layer boundary lines, select Modify Boundary from
the OCT Image menu.

2. Select the desired boundary lines to modify and make adjustments on those
selected scans.

3. Click Save, which triggers recalculation of measurements based on the new
boundary lines.

4. To manually adjust the disc boundary line in the baseline image, select Modify
Disc Baseline from the OCT Image menu. Make the required adjustments in the
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screen. Click Save, which triggers recalculation of measurements based on the
new boundary lines.

U'%’;"Note: Clean Diagnosis Data does not affect manually edited scans.

035" Note: Disc boundary line modifications of the ONH apply only to patient
scans where no 3D is available; otherwise the disc boundary would be
modified on the 3D scan.

6.2.6 Factors that Can Affect ONH Scan Quality

ONH scan not centered on the optic disc: During the ONH scan acquisition, the operator
should check to ensure the scan pattern is well centered on the optic disc. If it is not, the
operator should move the scan pattern to be centered on the disc displayed onscreen in
the en face window by clicking the disc center. If the operator does not center the scan
pattern on the disc, the RNFL thickness measurements may be affected. The software
automatically positions the RNFL TSNIT circle on the center of the optic disc after the
scan. However, if the measurement circle falls outside the scan pattern area because
the disc is too close to the edge of the scan pattern, some of the data may be missing.
You should retake the scan if this occurs.

Ideally, the TSNIT circle should be centered with respect to the edge of the scan
pattern. When offset from center, the widest distance between the TSNIT line and the
edge of scan pattern should not exceed three times the minimum distance between the
white TSNIT line and the scan pattern edge.

Check optic disc drawing and RPE tip placement: Ensure the optic disc drawing
accurately marks the edge of the optic disc boundary. Also ensure the RPE tip
placements are at the correct positions (end of RPE/choroid complex at the disc
margin). Redraw the optic disc margin drawing if required. Adjust the RPE/Choroid tips
placement if required. If the optic disc drawing or the RPE tip placement is not accurate,
the measurements can be affected. See the Verify RPE Tips section, as required.
Scans should be retaken if the RNFL measurement circle falls outside the scan area
after the disc drawing and RPE tip placement are in correct positions. This verification of
RPE tips can be done at any time by right clicking on the NFL result map. NDB analysis
is available for ONH when the baseline is derived from the clinician or by 3D optic disc
scan.

Check the layer segmentation accuracy of the Nerve Fiber ONH scan: The segmented
layers for ONH are ILM and NFL (Nerve Fiber Layer). If the segmentation lines are not
accurate, you should manually make the necessary corrections. If the segmentation is
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not accurate and you do not make the correction, the results will be affected. If you
perform manual correction, the results will be valid and the scan can be used.

6.3 Nerve Fiber ONH Change Analysis

The Change Analysis button is available on the Nerve Fiber ONH report when ONH
scans have been taken on three or more visits. Click this button and the system
displays the Nerve Fiber ONH Change Analysis report; when the patient record includes
both ONH and GCC scans, the system displays the Nerve Fiber ONH/GCC Change
Analysis Report (see section 6.5.4). The Nerve Fiber ONH Change Analysis report
appears as below when you have ONH scans from only two visits. It shows data from
the previous scan on top and the recent scan on the bottom.
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Figure 49 Nerve Fiber ONH Change Report, 2 Visits

The Nerve Fiber ONH Change Analysis report includes most elements of the Nerve
Fiber ONH report side by side for each scan (see page 73).

ﬂ%‘Note: Change values in the bottom row of the table are simple differences that
may not be statistically or clinically significant. The single-scan values are
the same as in the Nerve Fiber ONH Analysis.
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After three visits, the change analysis report changes, displaying up to four visits and an
RNFL rate of change graph, as shown below.

Nerve Fiber ONH Change Analysis Left/ OS
RNFL Analysis

um | RNFL Rate Of Change =-0.23 umfYr  95% CI(-0.98,0.52)  p=0.40
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Figure 50 Nerve Fiber ONH Change Analysis, 4 Visits

The report shows up to four Nerve Fiber ONH change analysis visits when there is no
GCC data available, as shown above. Recall that when the patient record includes both
ONH and GCC scans, the system displays the Nerve Fiber ONH/GCC Change Analysis
Report (see section 6.5.4). The report includes:

The RNFL thickness map for each eye on top

An RNFL Rate of Change graph in the middle plotting average RNL thickness
over time. Above the graph appears the estimated rate of change (in um) per
year, the range of the 95% confidence interval in brackets, and its p-value. When
the p-value is between 0.1 and 0.05, the slope and p-value appear with black text
against a light purple background, indicating marginal statistical significance.
When the p-value is 0.05 or less, the slope and p-value appear with white text
against a dark purple background, indicating statistical significance.

At lower left, the TSNIT RNFL thickness graph with different colored lines for
each visit

At lower right, an RNFL Parameters table that gives both RNFL thickness and
disc-related values, with cells colored relative to the normative database.
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6.3.1 Nerve Fiber ONH OU Report

The OU Report button is available when the patient record includes Nerve Fiber ONH
scans for both eyes. Click the OU Report button to generate the Nerve Fiber ONH OU
report. This report has all the same elements as the Nerve Fiber ONH Report and

includes comparisons between the eyes.
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Figure 51 Nerve Fiber ONH OU Report
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6.3.2 Nerve Fiber ONH/GCC OU Report

When the patient record includes both ONH and GCC scans for both patient eyes,
clicking the OU Report on the Nerve Fiber ONH report and the Nerve Fiber GCC report
both open the Nerve Fiber GCC OU Report. You can select from the Visits list on the
left which ONH and GCC scans to include, and then click the OU Report button to show
the report.

Ble Teoh OCTimage Dutabase Mansgement Home Hel

| oUReportiode X Right/OD Nerve Fiber ONH/GCC OU Report Exam Date:2012-11-08
L on | EenTime 185627 [ e— Exnm Time: 160031

NDB Reference Optic Nerve Head Map RNFL Summary Parameters

BEEEA® | commoos [ p— Exom T 160484
» A I

Priss Chanae Soabesis 011 Benog

Figure 52 Nerve Fiber ONH/GCC OU Report
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6.3.3 Verify or Adjust RPE Anchor Points

For the ONH scan only, the system automatically identifies the RPE anchor points (also
called end points or RPE tips). However, you can review and verify or adjust placement
of the anchor points. To do so, right-click on the ONH report and select Modify RPE
Anchor Points. The system displays one pair of scan images with yellow RPE anchor
points. It is sufficient to verify or adjust the anchor point placement on only one image
pair (out of the six pairs of radial scans taken). Use the arrow buttons to the right of the
images to select the desired pair. If you make adjustments, you must click OK while the
adjusted pair is on screen for the adjustment to be saved. If you move to another pair
and click OK, the adjustment will not be saved.

£

OK

Cancel

Figure 53 Verify or Adjust RPE Tips

6.4 Nerve Fiber 3D Disc Report

ﬂ"‘z‘:‘?Note: On the iScan Neuro system, descriptions of the 3D Disc scan and report
still are present because the system prompts you to take a 3D Disc scan for
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use as the baseline for the ONH scan. The 3D Disc baseline scan is
required for comparisons of the ONH scan to the normative database.

The ONH 3D Disc scan is presented very similarly to the 3D Retina scan. At upper left
is the SLO image, where you can view and modify the disc margin drawing for the 3D
Disc scan. The image below shows the different presentation controls.

Nerve Fiber 3D DiSC Scan Quality Index | Good 29 R|ght / OD

SLO 6.00 x6.00 Scan Size (mm)
ey y 3

Brightness &
Contrast controls
for SLO-like image

Baseline
control
buttons

V| Show Bnd

| Print Comment 061 o‘\;Qe
Figure 54 Nerve Fiber 3D Disc Report

6.4.1 Baseline Control Buttons
¢ Auto — Draws the disc margin on the en face SLO image.

e Add — Adds an anchor point on the image for disc boundary. Click the SLO
image to find the correct point (RPE tip) position, then click Add.

¢ Fit — Uses anchor points to draw the disc boundary to close contour.
e Clear — Clears any currently marked anchor points

e Save — Saves the resulting disc drawing as the baseline for the ONH scan.

U-‘{’t‘?Note: Click anywhere on the SLO image to select the horizontal (green line)
and vertical (red line) B-scans displayed at bottom and right, respectively.
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3D Fundus En Face

(8x8 mm 3D Fundus Enface — 385 x141) One Enface window and One NFL thickness
map window to visualize the nerve fiber over the superior and inferior arches

ST Neuros 134
)| i

OCTImage Database Management Home Help

3D Disc Fundus Scan Quality Index [ESBANEIN Right / OD

File Tools
Patient

‘ baseline, t1

J

8.00 x8.00 Scan Size (mm)

Yd

=
&

Neuro, test

IN

|

‘ NeuroTest, 22

(]

Visit
06/26/2015 27Scans

NYJS

s\

|

MAIATY
>

= 06/26/2015

0D 3D Disc Fundus  09:48:11
B | 0S 3D Disc Fundus 03:50:26 i
0D 3D Disc Fundus 13:04:44 L
0S 3D Disc Fundus 13:06:29
0D 3D Disc Fundus 14:57:33
0S 3D Disc Fundus 14:58:28
0D 3D Disc Fundus 16:19:54

3l An 20 Nien Eundus 152221 =
Tool

VBl
—NA AN/ oplevie

Figure 55 3D Fundus En Face
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6.4.2 Verify or Modify Disc Baseline

For 3D Disc scans, the system automatically calculates and draws the outline of the
optic disc to be used as the baseline. However, you can verify or modify the disc
baseline. To do so, select the Modify Disc Baseline in the OCT Image menu. A disc
image showing the automatically drawn baseline appears.

E Save as Baseline ﬂ [ Cancel ]

Figure 56 Modified Disc Baseline

Click and drag the anchor points to modify the disc outline used as baseline. When you
are finished, click Save as Baseline to save the changes.

ﬂgt? Note: The Nerve Fiber 3D Disc scan is the preferred source of the disc baseline
for the ONH scan. If an ONH scan was captured before a Nerve Fiber 3D
Disc scan, the disc baseline is based on the ONH scan until a Nerve Fiber
3D Disc scan is captured. At that point, the data is reprocessed.

035 Note: NDB comparison is only available when disc margin is derived from a 3D
Disc scan.

Normative database references for the 3D Disc report may not be valid if motion
artifacts are present in or near the disc. You can recognize motion artifacts by
disconnected/distorted blood vessel patterns or heavy black horizontal lines.

iScan User Manual Page 86 of 181 P/N 580-49328-004 Rev. A



When viewing the editor, note whether the baseline is based on an ONH or 3D scan.
For example, if the baseline is based on a 3D scan, the disc baseline may be displayed
in the wrong location in the ONH disc baseline editor. In this scenario, the shape of the
baseline is correct but located off center relative to the disc. To properly edit the
baseline, view and edit the original baseline scans.

6.5 Assessing the GCC

Figure 57 The GCC and Its Layers

The ganglion cell complex (GCC) encompasses three layers of ganglion cells in the
retina:

1. The retinal nerve fiber layer (RNFL) is made up of the ganglion cell axons,
2. The ganglion cell layer (GCL) is made up of the ganglion cell bodies,

3. The inner-plexiform layer (IPL) is made up of the ganglion cell dendrites.

The GCC becomes thinner as ganglion cells die from glaucoma. By measuring GCC
thickness, the GCC scan supports clinicians who diagnose and track glaucoma and
other diseases that affect the GCC layer.
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6.5.1 Nerve Fiber GCC Report

The Nerve Fiber GCC report includes a GCC thickness map, and NDB reference map,
an en face image, an OCT image and a thickness and volume parameters table to
support qualitative and quantitative assessment of the GCC. The elements are
described below.

Nerve F|ber GCC Scan Quality Index _ [7] View Reproducibility
Thickness Map

Right / OD

NDB Reference

2 G TRR

omm x 6mm
g i

W o
View Reproducibility
unchecked, so default |
GCC report appears.

")

LT

Average Thickness [Thickness (um)
Total
Superior

Inferior
Intra Eye Difference (5-])
FLV (%)
GLV (%)

Print ] l Change Analysis I l OU Report I ome
Figure 58 Nerve Fiber GCC Report
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GCC Thickness Map

At upper left appears a GCC Thickness Map. This map is 6 mm diameter and uses a
color scale to indicate thickness. The color key next to the maps explains the values (in
pMm) associated with the colors. Warmer colors from yellow, orange and red to white
represent greater values. Cooler colors from green to blue to black represent lesser
values.

The GCC map for a normal eye shows a broad sweep of bright color around the fovea,
indicating a GCC with healthy ganglion cells (healthy eye at left in Figure 59). (The
fovea has no ganglion cells and therefore shows darker color.) In glaucoma, the GCC
thins as ganglion cells are lost; consequently, the extent of bright color around the fovea
contracts (glaucoma eye at right in Figure 59).

Figure 59 GCC Thickness Maps: Healthy Eye (Left), Glaucoma Eye (Right)

NDB Reference Map

At upper right, a color-coded NDB Reference Map (overlying the en face image) shows
regions where thickness is normal (green), borderline (yellow) and outside normal (red).
The grey circle around the fovea is to exclude reference to normative data colors
because this region lacks ganglion cells.

Thickness and Volume Parameters Table

The table at right center reports GCC thickness and volume parameters. Applicable
measurements appear against a green, yellow or red background, indicating whether
the measurement is within normal (green), borderline (yellow) or outside normal (red).
Parameters include:

e Average GCC thickness (in um) overall (Total), in the superior and inferior
hemispheres, and the difference in average between the superior and inferior
hemispheres. GCC thickness is measured from ILM to IPL. Each measurement
appears against a green, yellow or red background, indicating whether the
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measurement is within normal (green), borderline (yellow) or outside normal
(red).

e FLV (%) Focal Loss Volume quantifies the amount of significant GCC loss. FLV
is expressed as a percentage of the map area with significant ganglion cell loss
(by volume). Early study results indicate that FLV may be the most accurate
parameter to distinguish glaucoma eyes from normal eyes, better than overall
average GCC thickness.

e GLV (%) Global Loss Volume quantifies the average amount of GCC loss over
the entire GCC map. GLV is the sum of the pixels where the fractional deviation
map value is < 0, divided by the total map area to give a percent loss of GCC
thickness.

f~—

=5 Note: If you change the age of the patient, you must manually refresh the GCC
scan to reflect the correct FLV% and GLV% values. Do this by either right
clicking the scan and selecting Reprocess Data, or selecting Clean
Diagnosis Data from the File menu. Refer to section 7.1.7 for more
information on how to clean diagnosis data.

Select the View Reproducibility checkbox to show the calculated range of
reproducibility for each thickness parameter.

Nerve F[bel’ GCC Scan Quality Index | Good 68 [V] view Reproducibility R|ght / OD
A
Result-2"Reproducibility Result Result+2*Reproducibility Within
GCC Parameters (percentile) (percentile) (percentile) Nomal
Borderine
Total Average (um) 87 (4.2%) 89 (9.2%) 92 (17.4%)
Superior Average (um) 85 (3.5%) 88 (8.4%) 91 (17.1%) -
Inferior Average (um) 88 (5.4%) 91 (11.7%) 93 (22.0%) Within
FLV (%) 0.000 (1.8%) 0263 (54.3%) 1332 933%) Normal
GLV (%) 4.146 (86.9%) 5913 (92.7%) 7.681 (95.7%) Borderiine
Outside
Nomal

View Reproducibility
checked. Parameters
table shows
reproducibility range.

: , —

[ Print 7] Change Analysis J [ 0OU Report J Comment J OpT O \/Qe

Figure 60 Nerve Fiber GCC Report with Parameters Table
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B-Scan Display

The B-scan at lower right is the currently selected vertical B-scan. The red lines on the

NDB Reference Map at upper right indicate the currently selected scan lines of the GCC
scan pattern, which correspond to the B-scan shown at bottom right.

¢ When you click on the NDB Reference Map, the red lines change to blue and the
vertical lines move to where you click. The vertical line then follows the pointer
until you click again, and the lines turn back to red. While you move the vertical
blue line, the B-scan also updates to show the B-scan at that location.

6.5.2 Nerve Fiber GCC Change Analysis

The GCC Change Analysis compares two visits only. The GCC scan registers the fovea
to support accurate registration (alignment) of GCC scans during comparison. Check
the fovea location on the NDB Reference map, shown as a yellow dot. It should be
about 1 mm off center toward the nasal side, and aligned with the red lines. If the fovea
is greatly off center, exclude it from change analysis. It is not possible to change the

fovea location in the GCC scan. If the patient has retina-based pathology, the scans
may not align correctly.

Nerve Fiber GCC Change Analysis Right/ OD

Scan Quality Index | Good 68!
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Figure 61 Nerve Fiber GCC Change Analysis
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The report includes:

¢ On the left side, a color-coded NDB Reference map overlaid on the retinal en
face image for each visit. As the legend to the right explains, green means within
normal, yellow means borderline and red means outside normal with respect to
the normative database for GCC thickness,

¢ In the middle of the report, a Thickness Difference Map shows thickness
differences (in um) between visits using a color scale, the legend for which is just
to the right.

e On the right side for each visit is the B-scan corresponding to the red vertical line
on the GCC thickness map. Use the mouse wheel to scroll through the B-scans.

e Atable at right center shows GCC thickness values and change between visits.

In the case of multiple visits when no ONH data is available, a Nerve Fiber GCC
Change Analysis shows a GCC thickness map for each visit at the top, a GCC Rate of
Change analysis in the middle, and a table showing average GCC thickness for the first
and last visits compared to the normative database.

Nerve Fiber GCC Change Analysis Left/ OS
GCC Thickness Map
Visit Date: 01/01/09 (40.0) Isit Date: 0201111 (42.1) it Date: 01/01/13 (44.0) Visit Date: 02/01/14 (45.1)
pm GCC Rate Of Change =-0.30 pm/Yr  95% CI (-1.54,0.95)  p=0.50

w © % = E] Age
01/01/09

0213
o213

Print | [ cnange analysis | [ oumepon | optevue

Figure 62 Multi-Visit Nerve Fiber GCC Change Analysis

Above the GCC Rate of Change graph appears the estimated rate of change (in um)
per year, the range of the 95% confidence interval in brackets, and its p-value. When
the p-value is between 0.1 and 0.05, the slope and p-value appear with black text
against a light purple background, indicating marginal statistical significance. When the
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p-value is 0.05 or less, the slope and p-value appear with white text against a dark
purple background, indicating statistical significance.

6.5.3 Nerve Fiber GCC OU Report

When the patient record includes GCC scans for both eyes, clicking the OU Report
button generates a Nerve Fiber GCC OU Report. This report supports assessment of
symmetry between eyes. At the top are the NDB Reference Maps for each eye. In the
middle, the same thickness and volume parameters table as described above (see page
88) and also includes inter-eye differences. At bottom are the vertical B-scans
corresponding to the red line on the NDB reference map for each eye. Click and drag
the red line or scroll on the map to change the current B-scan shown.

Right/ OD Nerve Fiber GCC OU Report Left/ OS

05/04/2011 14:58:27 [G56aT68Y  scan Quality Index G008 05/04/2011 14:59:29

|
j

Borderiine

NDB Reference

NDB Reference GCC Average Thickness (um)

Total

Superior

Inferior

Intra Eye Difference (S-)
FLV (%)

GLV (%)

—

Print ] [ Change Analysis ] op t® V\L]e

Figure 63 Nerve Fiber GCC OU Report
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6.5.4 Nerve Fiber ONH/GCC Change Analysis Report

When both ONH and GCC scans were acquired for an eye on three or more visits, the
Change Analysis button on the ONH and GCC reports generates a Nerve Fiber
ONH/GCC Change Analysis report. This report automatically displays thickness maps
and data for up to six visits for the current patient eye.
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Figure 64 Nerve Fiber ONH/GCC Change Analysis Report

¢ Thickness Maps: At upper left and center, the report shows thickness maps for
up to six GCC scans and six RNFL scans. The software automatically selects for
display the earliest two visits and the latest two visits. If desired, you can use the
list of visits in the column at left to select which scans to display.

e GCC Thickness Maps support evaluation of GCC thickness distribution
(color, pattern, and fovea centering) for consistency, scan quality, and
obvious measurement artifacts. Usually, the first two visits should be
reasonably consistent with each other and the last two visits should be
reasonably consistent with each other, unless a confirmed condition exists
to explain rapid change between two adjacent visits. Scans with clearly
identified image quality problems should be deleted to avoid inclusion in
change analysis. Compare images to the GCC trend to rule out
contradictory images or those that prompt data quality concerns.

o RNFL Thickness Maps support evaluation of RNFL thickness distribution
(color and pattern) and disc/cup shapes for consistency, scan quality, and
obvious measurement artifacts. Usually, the first two visits should be
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reasonably consistent with each other and the last two visits should be
reasonably consistent with each other. Scans with clearly identified image
quality problems should be deleted to avoid inclusion in change analysis.
Compare images to the RNFL trend to rule out contradictory images or
those that prompt data quality concerns.

o Comparison to NDB Table: At upper right, a table reports GCC and RNFL
measurements for the first and last visits. Table cells are color-coded with
respect to the normative database. This information helps you assess the status
of the eye relative to normal eyes over the time span between the first and last
visit.

« TSNIT Graph: At middle right is a TSNIT graph displaying RNFL thickness at
each visit. The TSNIT graph helps you assess RNFL thickness around the eye
relative to the normative database, as well as consistency and regions of change
between visits.

¢ Rate of Change Graphs: At bottom are graphs that plot age versus RNFL
thickness (left graph) and GCC thickness (right graph). Above each graph
appears the estimated rate of change (in yum) per year, as well as the range of
the 95% confidence interval in brackets, and its p-value. Different from other
threshold-based change detection methods, this change analysis does not apply
a fixed threshold for change detection, and makes no assumption of test-retest
variability. The rate of change estimate uses simple linear regression. It fits a
straight line to a graph of thickness data points versus age, and calculates the
slope of the line to determine whether it indicates a statistically significant change
in thickness.

¢ For the estimated rate of thickness change, the report automatically
includes thickness measurements from all visits. Including more data with
a longer period of followup tends to increase the accuracy of the estimate.
Optovue recommends that you delete poor quality ONH and GCC scans
to exclude them from the analysis.

e The 95% Confidence Interval indicates the range of slope within which the
true slope is, with 95% probability. The narrower the range, the more
reliable the slope estimate. When the range includes zero, it means the
estimated slope is not significantly different from zero statistically. Factors
affecting the confidence interval include measurement variability, duration
of followup, and number of tests performed.

e The p-value indicates whether the estimated slope is statistically different
from zero. A smaller p-value means it is less likely the true slope is zero.
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When the p-value is between 0.1 and 0.05, the slope and p-value appear with black text
against a light purple background, indicating marginal statistical significance.
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Figure 65 Marginally Significant Change

When the p-value is 0.05 or less, the slope and p-value appear with white text against a
dark purple background, indicating statistical significance.
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Figure 66 Statistically Significant Change

The rate of change, if estimated with high reliability, could be used to estimate RNFL
and GCC thickness measurements in future years. For example, a rate of -3 um/year
could mean loss of 30 um of thickness in 10 years if it continues at the same rate. For
reference, based on the OCT normative database (cross-sectional data set), the
estimated age-related loss of average RNFL and average GCC is less than 0.2
pm/year. It is likely that an individual’s age-related loss may have a different rate from
the average value. However, if a much higher rate of change is detected in an eye,
further clinical evaluation may be necessary.
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6.6 Cornea Report
Note: Epithelial mapping is not available for sale in the USA

6.6.1 Cornea Pachymetry Report

The Cornea report includes the OCT image on top, a Pachymetry and Epithelium
Assessment table below to the left, and a pachymetry and Epithelium maps showing
corneal thickness at lower right.
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fome belp
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. s . Epithelial map
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' . diameter.
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Priet Change Analysis OU Report Comment

Figure 67 Cornea Pachymetry Report Manual Boundary Adjustment

Pachymetry Assessment Table

The Pachymetry Assessment table supports evaluation of symmetry by comparing
thickness values for the opposite sectors SN-IT, and the opposite hemispheres S-I,
within the 2 mm to 5 mm zone.

Manual Boundary Adjustment

Use this feature to manually adjust placement of the boundary lines the system
automatically fit to the anterior and posterior cornea surfaces.

1. To manually adjust a boundary line, click the B-Scan button in the Tool menu and
select a boundary line, or right-click on the OCT image and select Modify
Boundary.
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2. Adjust the boundary lines to fit each surface as necessary, then click Save, which
triggers recalculation of measurements based on the new boundary lines.

Factors that Can Affect Accuracy of Thickness Measurements

e Cornea scan centering: Poorly centered scans can affect thickness accuracy.
Make sure the pupil is centered on the alignment reticle within the scan window
guidelines. If the pupil is not well centered, retake the scan.

e Accurate placement of cornea surface boundary lines: The software
automatically detects the anterior and posterior surfaces of the cornea and fits
lines to each surface. If the surface boundary lines are not accurate, you should
manually correct their placement. Inaccurate boundary lines cause inaccurate
thickness measurements. You should not use measurements if you do not
correct the boundary lines, but if you correct them, you can use the resulting
measurements.

e Precision (repeatability and reproducibility of cornea thickness measurements in
the central 0-2 mm for normal and cornea [pathology] patients): See the following

table.
Table 1 Precision for Normal and Cornea Patient Scans
Central Cornea 0-2 mm Normal Patients | Cornea Patients
Number of Scans 70 72
Overall Mean (Overall SD) 549.83 (20.85) 531.80 (48.20)

Repeatability SD* (Min, Max) 1.71(1.71,1.71) 3.58 (3.58, 3.58)

Reproducibility SD** (Min, Max) | 1.71 (1.71, 1.71) | 14.52 (14.52, 14.52)

* Standard deviation estimate among measurements taken on same subject using same
operator and device in same testing session with repositioning.

** Standard deviation estimate among measurements taken on different subjects using
different operators and devices, including repeatability; in some cases maximum
reproducibility estimates were impacted by mean thickness difference between subjects in
different sites.
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6.6.2 Cornea OU Report

Click the OU Report button to display the Cornea OU Report. (The OU Report button is
available if you have acquired cornea scans for both eyes.)
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Figure 68 OU Report for Cornea Scan
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6.6.3 Pachymetry & Epithelium OU Report

Click the OU Report button to display the Cornea OU Report. (The OU Report button is

available if you have acquired cornea scans for both eyes.)
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6.6.4 Cornea Change Analysis

Click the Change Analysis button to generate a Cornea Change Analysis. (The
Change Analysis button is available when there are cornea scans from two or more
visits for this patient.) This report compares Cornea scan results between two visits. For
each visit, the report shows cornea and epithelial thickness map, OCT image and
pachymetry assessment values, from left to right, with the earlier visit to the right, and
the more recent visit to the left. The system does not perform image registration for the
Cornea scan.

Cornea Change Analysis Right / OD
Previous Scan 04/01/2010 11:15:44 Scan Quality Index [Good 42
| 3
740 Pachymetry Assessment
Z;‘z Superior - Inferior Comparison within Smm zone
—620 SN-T(2-5mm): 134 S-(2-5mm): 19
::E 7_57 Min-Median: -25 Min-Max -70
500 & Min: 544 LocationY: -264
:; Min thickness (x y) -0.469mm, -0.264mm shown as *
380
340 593
300 ¥l 6mm x 6mm
Recent Scan 04/05/2010 10:21:52 Scan Quality Index NG00 372

Pachymetry Assessment

Superior - Inferior Comparison within Smm zone

SN-IT(2-5mm): 40 S-(2-5mm): 24
Min-Median: -28 Min-Max -73
Min: 543 LocationY: -299

Min thickness (x y) -0.668mm, -0.299mm shown as *

[C) Show Original

T Sptevue

Figure 70 Cornea Change Analysis Report

Pachymetry scan alignment for change analysis is based on alignment to the pupil
center at the time of capture.

035 Note: The maps in the Cornea Change Analysis show differences between
visits without statistical analysis. Observed changes may not be statistically
or clinically significant.
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Pachymetry Change Analysis

Exam Date: 06/06/2012 15:28:03

Print 0U Report

2 Sigral Srength ndax El
Pachymetry Map

Prev  Nea Prev  Nes

swem@-sme): [38 [ sxzsem):[35 [41
o [T [99 weaten: [0 [
. ™ ol e

Min thickness indicated s *

Epithelium Map 1,

Prev Nee Prev Net
ssmm): [9 [ 1@smm):[56 [4
o[8[ e [ 5
suoe: [257[05°  momec [0 [47

MeyMax thciness indcated as */+

Figure 71 Change report for Pachymetry & Epithelial
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power [45.23 [s182 [64
Curvature radus
Anteror:[7.284  Posenor:[g117
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6.6.5 Lens fitting Report

The Lens fitting Report maps the clearance (Vault) space between the posterior surface
of the scleral lens and the anterior surface of the Cornea 6mm.

The index of refraction must be entered to see the results. The clearance assessment
statistics table supports evaluation of symmetry by comparing thickness values for the
opposite sectors SN-IT, and the opposite hemispheres S-I, within the 2 mm to 5 mm
zone.

Lens Fitting

\_
———X 5
i

—our Clearance Assessment | bmm

Print Change Analysis Comment optevue

Figure 72 Lens Fitting Report
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6.6.6 Lens Fitting-Clearance Assessment Change Analysis

Change between clearance maps of Lens fitting exams

TausE ~
Clearance Assessment Change Analysis Jm%
Previous Scan 11/04/2015 11:21:47 Scan Quality Index | Good 56 L IVUE V52003 |
— 400
.-—350
:—32’3 Clearance Assessment{ R.1.1.40)
—2m ~— Cleara_m_ce Assessment statistics within
[ o SNAT(ZEmm): 133 SH(@5mm): 135
__zm Min: 7 Location'Y: 2238
e Min-Median: -106 Min-Max: -177
. Min thickness (x, y) 0.803mm, 2.238mm
0 shown as™
40
Opm
— 400
.-—353
:—329 Clearance Assessment{ R.1.1.40)
280 CIeara»n»ce Agsessment statistics within
C o SNHT(2-5mm): 146 S-(2-5mm): 138
__m Min: B LocationY: 1834
1@ Min-Median: -109 Min-Max: -193
10 Min thickness (x y) 1.535mm, 1.834mm
=0 shown as™
40
opm  Clearance Assessmentl 6mm
Recent Scan 11/04/2015 11:22:26 Scan Quality Index | Good 57

optevue

Figure 73 Change between clearance maps of Lens fitting exams
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6.6.7 Cornea Angle Report

A sample Cornea Angle report appears below. Use the angle tool from the Tool pane to
measure the angle.

i Fle Tools OCTImage DatabaseManagemert Home Help

.'T‘:;E‘JH Cornea Angle Scen Quality index | EEGIEAN Right / OD

IN3ILYd

VR
05/10/2010 23 Scans
: 0D Comea Pachymetry 162524 &

; 0D Comea Angle 16:26:00

0D Comea Angle 16:27:32
[:] 0 Comea Pachymetry 16:30.03
[] os comea Pecymety 163013
0S Cornea Angle 16:32:18

MINIY

E 0S8 CorneaAngle 16:34:14
0D ComeaAngle 163515

N aE ) i .
= optevie

v

Figure 74 Cornea Angle Report

If you have acquired Cornea Angle scans for both eyes, click the OU Report button to
generate a Cornea Angle OU Report. A sample report appears below.

i Fle Tools OCTImage Database Management Home Lelp

OU Report Mode

Cornea Angle OU Report
Scan Quality Index [EGSENGIN

- Please select an OS scan
05/10/201016.52.18 Scan 05/10/2010 16:35:15

05/10/201016:34:14

N3V

Right / OD

2
Left/ OS
;‘1
3 B ) i@ Scan 05/10/2010 16:34:14 Scan Quality Inclex |EGEGNAGN
optevue

Figure 75 Cornea Angle OU Report
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If you have acquired multiple Cornea Angle scans of the same eye, click the Change
Analysis button to generate a 4 scan Cornea Angle Report. A sample report with 2
scans appears below.

Anterior Display Report Right / OD

Prist Change Analysis

Figure 76 Multi Image report
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6.7 iWellness Report

The iWellness report combines results from the Retina Map scan and the GCC scan.

]

iWellness Scan Quality Index | Goad B8 | [ View Reproducibility ~Iyliv s VU

Average Thickness
Total |es Within
Superior 89 Normal
Inferior Borderline

Superior - Inferior 7
FLY (%)
GLY (%) 10,157

VeV
01 ‘
/
- N
0 ) 200
! Uy e 951 1
] L g
Bl i e y 100
bl . /3
PR T ) e |
T — Opm  95%-99%
o

/Wellness &= Iy
SPiavos

Figure 77 iWellness Report with Averaged Raster Scans

The top right OCT image is a vertical scan through the fovea; it does not change. The
top left OCT image is the currently selected horizontal raster scan (one of seven) from
the Retina Map scan; the six other raster scans appear in the middle of the report. Click
one to display it at upper left. Each raster scan is an average of five scans. The report
also includes:

¢ A Full Retinal Thickness map at lower left. The map colors report retinal
thickness using a color code, the legend for which is just to the right. An overlaid
map centered on the fovea defines nine ETDRS-like sectors, constructed with 1,
3, and 5 mm diameter circles divided into temporal, superior, nasal and inferior
areas. The map reports average retinal thickness in each sector.

e Another ETDRS-like map at bottom center shows the same average thickness
values in each sector and includes a color code with respect to the normative
database, the legend for which is to the left of it.
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« An NDB Reference map of GCC thickness at middle right, which reports GCC
thickness in colors with respect to the normative database. The colored map
overlays the en face scan image of the retina.

23 Note: GCC thickness has clinical significance in diagnosis of glaucoma. The
reported parameters are Total, Superior, Inferior, Superior — Inferior
(difference), FLV% and GLV%. The values are color-coded with respect to
the normative database.

¢ An Average Thickness table at lower right. The reported parameters are Total,
Superior, Inferior, Superior — Inferior (difference), FLV% and GLV%. The
values are color-coded with respect to the normative database.

Select the View Reproducibility checkbox to show the calculated range of
reproducibility for each thickness parameter.

iWellness

Scan Quality Index | Goad 65 [4] View Reproducibility

e
~Iiyrivs v

Retina Thickness Parameters

Fovea (um)

Parafovea (um)

Para 5. Hemisphere (um)
Para 1. Hemisphere (um)
Para Temparal (um)
Para Superior ()

Para Nasal (um)

Para Inferior (um)
Perifovea (um)

Peri 5. Hemisphere (um)
Peri I, Hemisphere (um)
Peri Temporal (m)

Peri Superior (um)

Peri Nasal (um)

Peri Inferior (um)

Result-2*Reproducbilty Result
(percentie) (percentie)

Result+2'Reproducbiity
(percentie)

325 (>99%)
300 (10.1%)

table shows

reproducibility range.

View Reproducibility
checked. Parameters

309 (91.1%)
265 (7.9%)
258 (7.4%)

317 (97.2%)

322 (88.0%)
257 (7.6%)

GCC Parameters

Total Average (um)
Superior Average (um)
Inferior Average (um)
FLY (%)

GLY (%)

Result-2*Reproducibility Result
{percentile) (percentile)
83(1.1%) 85(2.4%)
86 (4.7%) 8
(i) 1 R
278 G5%) T —
9,003 (97.1%) 10.157 (97.9%)

Result+2*Reproducibiity
(percentile)
87 (5.1%)
91 (18.4%)
84 (1.4%)
4.331 (>99%)
11.312 (98.4%)

Borderline

‘within
Normal
Borderline

0U Report

optevue

Outside.
Normal

Figure 78 iWellness Report with Parameters Table
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6.7.1 iWellness OU Report

Click the OU Report button when iWellness scans have been taken for both eyes. The
iWellness OU Report includes the elements of the iWellness report for both eyes side
by side. In the OU Report, the table reports differences in thickness parameters
between eyes. A sample iWellness OU Report appears below.

X X ————————
Right/ OD iWellness OU Report LEIL U
05/04/2011 15:02:44 Good 65 Scan Quality Index | Good b8 05/04/2011 15:04:13

Full Retinal Thickness

P

Ganglion Cell Complex Thickness {pm) oD oS oD - 05 Within
Total [ss [EE-4 Homal 5% 5%
Borderli g
Superior B = 1 orderline 5%-95%
Inferior B! -8
Superior - Inferior 7 -2 WIS
® ~ FLY (%) 1,084 |2.520
L We"ness Eam GLY (%) 10,157 5,862 |4.295
optevue

Figure 79 iWellness OU Report

End of section
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7 Main Menu

This section provides an overview of the main menu. The figure below shows the six
main menu items.

@ No patient selected - iVue

File Tools OCTImage Database Management Home Help

Figure 67. iVue Main Menu Toolbar

7.1 File Menu

@ No patient selected - iVue

File | Tools OCTImage Database Management
| —

Print Setup...

Print Header Info

Data Transfer >

Archive

Batch Process >
71 Clean Diagnosis Data >

Clean and Batch Process All Patients

Delete Unused Yisits {0 Scans) e

Exit

Figure 68. File Menu

7.1.1 Print Options

¢ Print: Prints the current report either to an electronic file or to hard copy,
depending on the printer you choose. Make sure the chosen printer is connected
and ready to print.
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e Print Setup: Opens the Print Setup dialog, where you can select the printer and
adjust print preferences.

r 3
Print Setup - @

Printer
Name: Adobe PDF v Properties...
Status:  Ready

Type: Adobe PDF Converter
Where:  Documents\" pdf

Comment:

Paper Orientation

Size: ILetler ﬂ % Portrait

Source: | Automatically Select | " Landscape
Network... ok | cancel | ‘

Figure 80 Print Setup Dialog

¢ Print Header: Opens the Print Header dialog. Use it enter practice information to
be included on all printouts. Name is required, others are optional. If no name

has been entered previously, the Print Header dialog also appears when you
click Print.

Print Header @

Name (Required): I

Address: |

Phone No.: I

Figure 81 Print Header Dialog
7.1.2 Print Setup

Selecting Print Setup from the menu displays the standard Windows™ Print Setup
window.
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7.1.3 Print Header Information

This option displays the window to insert the practice or facility information that you wish
to be printed at the top of every report when printed or saved as a digital file (.jpg and/or
PDF).

7.1.4 Data Transfer

This option displays the Output Data function, enabling you to transfer part or all of the
data required, for a variety of reasons, including clinical studies.

7.1.5 Archive Data

Patient data is automatically backed up onto a removable backup hard drive on the right
side of the unit (from the operator’s perspective), underneath a plastic cover (see Figure
4, page 31). When the system hard drive and backup drive are completely full, it is
necessary to remove data from the system to make room for new scan data. You can
archive to a network drive (if the iScan system is connected to your office network); or
you can archive to an external USB hard drive (formatted in NTFS format). Archived
data is retrieved automatically as long as the network drive or external USB drive is
connected to the system. Before archiving, you must set the archive drive: Select Tools
> User Preference and use the Archive Drive field in the User Preference dialog. See
section 7.2.1 for details.

U“-‘t‘fﬁlmportant Note: Unlike automatic backup, archiving removes the raw
patient data from both the primary and backup hard drives. We highly
recommend that you back up the archive drive, so you maintain a
backup copy of all patient data. We also recommend that you continue
archiving data to the same drive as long as possible to maintain all archived
data together. To ensure the security of your patient data, call Optovue
Technical Support for assistance before archiving patient data.

Hardware and Setup Requirements to Archive
The hardware requirements to archive are:

e To archive to a USB external hard drive: At least two same-size external hard
drives, at least 1TB each in size, one to be the primary archive drive and the
other to be the secondary archive drive. See setup instructions below.

ﬂ"‘gt’?Note: The secondary drive is necessary to back up the primary drive, in case
the primary drive becomes corrupted or inaccessible.
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e To archive to a network drive: The system computer must be on the office
network and have a drive letter mapped to the network archive drive, which
resides on the office server computer. To map to the network drive, use Windows
Explorer to open the My Computer (or just Computer) folder on the iScan
system computer, then map a drive letter to the chosen archive folder on the
network drive. For data security, the network drive should be backed up
regularly, which usually happens as part of the regular backup of the server.

Set Up Primary and Secondary USB Drives

1. Connect the hard drives to the system computer one after the other so that the
system can identify each drive uniquely. Write down the drive letters assigned to
each hard drive by Windows. You will use them later to specify the primary and
secondary archive drives in the User Preference dialog.

2. Format both external hard drives in NTFS format. Rename one Primary Archive
and the other Secondary Archive. Then physically mark—write on--each external
hard drive to distinguish the Primary Archive and the Secondary Archive.

=5 Note: If you are using a network attached storage device (NAS drive) as the
primary archive drive, use Windows Explorer to open the My Computer (or
just Computer) folder on the system computer, then map a drive letter to a
folder on the NAS drive. Make sure to back up the NAS drive periodically if
you are not using a secondary archive drive.

3. Select User Preference from the Tools menu.

File | Tools | OCT Image Database Management Home Help
1

User Preference |

Figure 82 Tools Menu
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The User Preference dialog opens.

f User Preference &‘
s Date Format | MM/dd/yyyy v
Allow Save Eye Blink Data | Yes -
Archive Drive: -

Secondary Archive Drive: =

Scan Auto Save:
Primary backup drive M

Secondary Backup Drive

Retina Map Default Display Map: NDB Reference Map -

Retina Cross Line Default Display: | Both -

¥| Auto saving PNG
PNG directory: C:\Eyepacs

L OK Cancel J

= —— =]

Figure 83 User Preference Dialog

4. Set the drive letter for the Primary Archive Drive and for the Secondary Archive
Drive. Click OK.

You have to perform these initial steps only once. Once set up, follow the procedure
below to perform scheduled archiving. Once you complete archiving, remove from the
system and securely store the secondary archive.
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Steps to Archive

Follow these steps to archive patient data.

1. Select Archive from the File menu.

@ No patient selected - iVue

File | Tools OCTImage Database Management

Print Setup...

Print Header Info

Data Transfer »
Archive

Batch Process »
Clean Diagnosis Data »

Clean and Batch Process all Patients

Delete Unused Yisits (0 Scans)

Exit

Figure 84 Archive Selection

2. The Archive dialog opens. You can use the Search field to search for specific
patients, or leave it blank and use the Sort By field to search for all patients or for
scans by visit date. Normally, users leave the Search field blank and proceed.

Search:

Sort By LAST VISIT TIME ™

Time Criteria iSpecify Time IV|
2/ 172014 v to 3/ 472014 v

l Deselectall Patient

’ | Collapse/E xpand ‘

|

Search ’

iScan User Manual

Figure 85 Specify Visit Dates to Archive
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4. In the Sort By field, you can select:
o ALL to archive all scans currently on the system hard drive.

e LAST VISIT TIME to archive scans based on the visit date. In the Time Criteria
field you can select:

o Specify Time to archive scans from the range of visit dates you specify in
the date fields below.

e This Week to archive scans taken this week.

e Today to archive scans taken today.
3. Click the Search button. A patient selection dialog opens.

4. Since you have searched for all patients or by date so far, the expected action at
this point is to click the Select All Patients button, rather than select specific
patients. Selected patients have a checkmark in their checkbox.

5. Click the Start Archive button. A System Status dialog opens and shows
archiving progress and remains until archiving is complete.

6. Click the Exit button.

7.1.6 Batch Process

Use Batch Process to pre-process all scans that have not been processed yet by
opening in the REVIEW window. This reduces the time required to open scans in the
REVIEW window. Select Batch Process from the File menu, and then select from the
four further options: Current Visit, Current Patient, Today’s Patients, All Patients.

@ No patient selected - iVue

‘{ET‘ Tools OCTImage Database Management Home Help

i Print Setup...
Print Header Info
Data Transfer >
Archive
Batch Process 4 Current Visit
Clean Diagnosis Data » Current Patient
Clean and Batch Process All Patients Today's Patients
Delete Unused Visits (0 Scans) All Patients »
Exit _J

|

Figure 86 Select Batch Process
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If you installed a system software upgrade from Optovue that includes new analysis
algorithms, you should clean scans of previous processing before batch processing all
patients. To do this, select Clean Diagnosis Data from the File menu (see next section
below). When complete, select File > Batch Process > All Patients.

Batch Process works best when the system is not in use. Processing time depends
upon the number of patients and scans in the database.

7.1.7 Clean Diagnosis Data

Clean Diagnosis Data removes any previous analysis processing, leaving only the raw
(clean) scan data. This enables reprocessing the clean data with the current analysis
algorithms, either by opening a scan in the REVIEW window, or by using Batch
Processing (see previous section). Clean Diagnosis Data does not remove manual edits
to scan data.

To clean diagnosis data, select File > Clean Diagnosis Data, and then select from the
further options shown below.

@) No patient selected - iVue

File | Tools OCTImage Database Management Home Help
Print Setup...
Print Header Info g
There are no ity
Data Transfer >
Archive
Batch Process > ol
Clean Diagnosis Data » I Current Yisit
Clean and Batch Process All Patients Current Patient  »
Delete Unused Visits (0 Scans) I All Patients » Glaucoma ONH
Exit Retina Map
Cornea Pachymetry
[ Show All ] [ Show Today ]

Figure 87 Clean Diagnosis Data Options

7.1.8 Clean and Batch Process All Patients

This process enables you to clean and batch process all patients (all scans on the
system) with one click: Select File > Clean and Batch Process All Patients. This
provides an easier way to remove previous processing (except manual scan edits) and
process all scans again, which is especially useful after a system software upgrade that
provides new analysis algorithms.
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7.2 Tools Menu

User Preference is the only option in the Tools menu.

File | Tools | OCT Image Database Management Home Help

User Preference

| i
Figure 88 Tools Menu

7.2.1 User Preference Dialog
The User Preference dialog enables you to modify various system settings.

[ e m— S |
Date Format [MM/ddjyyyy -
Allow Save Eye Blink Data: [Yes v]
Archive Drive: [ v]
Secondary Archive Drive: [ v]
Scan Auto Save: Yes
Primary backup drive: M
Secondary Backup Drive: [ v]
Retina Map Default Display Map: [NDB Reference Map v]
Retina Cross Line Default Display: llst v]
["] Auto saving PNG

Figure 89 User Preference Dialog

¢ Date Format: Set the date format.

o Allow Save Eye Blink Data: Select Yes to save even if the system detects
blinks, or No to force a rescan when the system detects blinks.
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¢ Archive Drive: Set the primary archive drive (see section 7.1.5).
¢ Secondary Archive Drive: Set the secondary archive drive (see section 7.1.5).

e Scan Auto Save: The unchangeable Yes setting causes Capture and Save to
occur automatically in succession.

¢ Primary Backup Drive: You cannot change this. The primary backup drive is the
one under the cover on the right side of the system (from the operator’s
perspective).

e Secondary Backup Drive: Select the mapped drive letter for an optional
secondary backup drive you have set up. A secondary backup drive would be
used for recovery in case of corruption of the primary backup drive.

¢ Retina Map Default Display Map: You cannot change this feature.

e Retina Cross Line Default Display: Set which scan line(s) to display by default,
1st, 2nd or Both This applies to Retina Cross Line and Retina OU Cross Line
reports.

Click OK to save your changes, or click Cancel to discard them.

7.3 OCT Image Menu

The options available in the OCT Image menu vary based on whether you are in
PATIENT, SCAN, or REVIEW mode.
In PATIENT mode, the menu provides three options:

¢ Modify Baseline

e Modify Boundary

¢ Reload Baseline
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In SCAN mode, only Scan Parameter Setting is available.

In REVIEW mode, only Modify Boundary and Scan Parameter Setting are available.

File  Tools | OCT Image | Database Management Home

Basi Average Property

Scan Parameter Setting

LN3ILVd

Figure 90 OCT Image Menu

7.3.1 Manual Scan Adjustment for Scan Capture

Select Scan Parameter Setting to adjust the settings for axial length, refractive state
and polarization. The manual settings you choose override the system’s automatic
settings.

=1553 - , 15mm
AutoZ | ZMotor: 375

-157% - , 10D
AutoF | Focus: 000
0, , 100

AutoP | PMotor. g5

S

Figure 91 Manual Scan Adjustment Dialog

These are the manual scan adjustment buttons with their functions. The numerical
values for Z Motor, Focus, and P Motor change as you move the sliders.

e Auto Z: adjusts for the axial length

e Auto F: adjusts for refractive state
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e Auto P: adjusts for polarization

7.3.2 Average Property
Click Average Property to adjust the frame average value.

W

Default Frame Average: (O Off (5 Auto O Manual

Match Yalue:

Figure 92 Frame Average Property Dialog

7.3.3 Modify Disc Baseline

Click Modify Disc Baseline to display the en face image of the optic disc. You can then
review and adjust the disc boundary determined by the software. Changes you make
trigger recalculation of measurements based on the new disc boundary.

Draw Disk.

-
am

E Save as Baseline i [ Cancel I

Figure 93 Video Disc Baseline Editor
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7.3.4 Modify Boundary

Click Modify Boundary to display all scans from the selected pattern (Retina, Nerve
Fiber, and Cornea). You can then review and adjust the segmentation boundary lines
identified by the software. Move the cursor over a line until the cursor changes to a
small plus (+) sign, then click and drag the line to the desired location. Click Save.

Figure 94 Segmentation Lines

035 Note: You cannot undo or batch-clean adjustments you make to segmentation
lines. You can only further readjust them manually.

7.3.5 Scan Parameter Setting

Use the Scan Parameter Setting dialog to select whether OCT scans appear in
grayscale or color during scan acquisition and review. Note that the Scan Parameter
Settings should be established in User Preference.

Scan Parameter Setting
Scan OCT Image
(O Gray Scale (3 Color Scale
Review OCT Image
(®) Gray Scale (O Color Scale (O Same As Scan
| OK ‘ l Cancel

Figure 95 Scan Parameter Setting Dialog
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7.4 Database Management Menu

In the Database Management menu, you can create, edit and delete physicians,
operators and diseases, which you can then associate with exam data. You can also
move visits to another patient, and recover scans. Note that all menu options are
available.

Database Management | Home Help
Physician
Operator
Disease
Maove a visit to another patient

Recover Scans >

Figure 96 Database Management Menu

7.4.1 Physician
Use the Physician Editor to add, edit or delete physicians.

Physician Editor

Last Name First Name: Middle Name

=] (=) [=] =]

Figure 97 Physician Editor Dialog

0=5" Note: You cannot delete a physician if any scan data is associated with that
physician.
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7.4.2 Operator
Use the Operator Editor to add, edit or delete system operators.

7.4.3 Disease

Use the Disease Editor to add, edit or delete disease categories.

Disease Category Editor [

Description: ]

OK Cancel |

) Il
Figure 98 Disease Editor Dialog

Delete Add l Edit 1

T ]

0=5 Note: You cannot delete a disease if any scan data is associated with that
disease.

7.4.4 Move a visit to another patient

Select Move a visit to another patient when exam data was incorrectly taken under
the wrong patient.

1. Select the patient and visit to move.

2. Select the Move a visit to another patient option from the Database
Management menu. A confirmation message appears.

r

Optovue iVue

! E Move the selected visit from "BY067, BY067 " to another patient?
.

[ es ] [ Mo ]

Figure 99 Move Selected Visit Confirmation Message
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3. Select the patient to whom the visit is to be moved.

This window allows you to move the selected visit from one patient to another.
Please select a patient to move to

ANTERIOR SEG CASE=1,LINE, ANGLE SCANS - LENS VIEW,, 1940-01-01F,
CORNEA CASE#1,GOOD LONG LINE, 3D, PACHY SCANS,, 1947-01-01,F,
CORNEA CASE#2,LINE, PACHY SCANS, , 1974-01-01,F,

CORNEA CASE#3,POWER SCAN,, 1947-01-01,M,

CORNEA CASE#4,LINE,PACHY,RETINA ENFACE SCANS, , 1933-01-01,F,

NFL CASE#1,0NH,GCC, 3D - OU 1VISIT,, 1962-01-01F,

NFL CASE#2, **FIELDS O5**_3VISITS_ONH,GCC,3D,,1954-01-01,M,

NFL CASE#3, **FIELDS O5**_3 VISITS_GCC,ONH, 30,,1938-01-01F,

NFL CASE#4, **FIELDS OD**_4 VISITS_GCC,ONH, 3D,, 1966-01-01,M,
RETINA CASE#1,GRID,MAP, 3D+GOOD ENFACE OD,,1946-01-01,F,

RETINA CASE#2,GRID,MAP OU, 3D ENFACE,, 1955-01-01,F,

RETINA CASE#3,CROSS LINE,MAPS, 3D+GOOD CHANGE OD,, 1977-01-01,M,
XR RETINA CASE#1,MAPS W/CHANGE, CROSSLINE, WIDE 3D,,1928-01-01,M,
XR RETINA CASE#2,MAPS, WIDE 3D, CROSSLINE SCANS,, 1946-01-01,F,

XR RETINA CASE#3,MAPS, WIDE3D, CROSSLINE SCANS, , 1932-01-01,F,

XR RETINA CASE#4,MAPS, WIDE 3D,CROSSLINE, CHANGE,, 1934-01-01,F,
XR RETINA CASE#5,MAPS, CROSSLINE, WIDE 3D,,1938-01-01,F,

f oK
Cancel

Figure 100 Select patient to move exam data to

4. Click Yes to confirm the move or No to cancel it.

! E Move the selected visit from "BY067, BY067 " to "BV095,BY095,,1955-11-02,F,"?

[ fes ] [ Mo ]

Figure 101 Move Visit Confirmation

7.5 Help Menu
File Tools OCTImage Database Management Home ﬂelpl

About iVue. ..

| Basic Search m Upgrade i

Figure 102 Help Menu
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7.5.1 About iVue

Select About iVue from the Help menu to display the About iVue dialog, which provides
general information about the system, including software version number, license key

and activated version.

About iVue

iVue
Yersion 2016.3.017
©2004-2016 Optovue, Inc. All Rights Reserved.

email:  support@optovue.com
website:  http:/fnwaw.optovue.com

=

License Key: 03E06-16C06-34W45
Activated Version: iScan Comprehensive
Wiew All Licenses ... oK

iScan User Manual

Figure 103 About iVue Dialog
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iScan Versions

There are two versions of iScan: iScan Essential and iScan Comprehensive. These
versions are distinguished by the scans available in each, as shown below.

Scans iScan Comprehensive iScan Essential
iWellness X X
Cross Line X
Retina Map X X
3D Retina X
GCC X
ONH X X
3D Disc X X (taken once, as a reference, no review)
Pachymetry X
Angle X

7.5.2 Upgrade

Select Upgrade from the Help menu to display the feature upgrade dialog. Use this
dialog to select an available license to upgrade features or to upgrade to the latest
software version.

F-

Please select a feature to

[ 7]

iVue Main License |

0K ’ ‘ Cancel ’

Figure 104 Feature Upgrade Dialog

End of section
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8 System Maintenance

8.1 Error Codes

If the system displays an error code; follow any directions displayed, if no directions are
associated with the error code, record the number, close the program and restart the
software. If the error fails to clear close the software and turn off the system then reboot
the entire system. If the problem persists call Optovue Technical Support.

8.2 Routine Cleaning

8.2.1 Clean the Ocular (Front Objective) Lens

can cause a weak OCT image or a blurry video image and may skew
scanning data. The ocular lens can be unclean due to smudges from contact
with eyelashes, the nose or fingers; or excessive dust or dirt from the
environment.

: Caution: Make sure the front lens is clean before scanning. An unclean lens

Optovue recommends cleaning the ocular lens regularly using:
¢ Lens cleaning solution
e Lens cleaning paper
Wet the lens paper with cleaning solution and wipe the ocular lens with one pass in one

direction. Discard the used lens paper. Use a new sheet for each wipe until the lens is
clean.

8.2.2 Clean the Facemask
Optovue recommends cleaning the facemask between patients using either:

¢ An isopropyl alcohol wipe

OR

e A disinfecting agent, such as an anti-germicide or isopropyl alcohol, on a clean,
lint-free cloth

0= Note: You can use a biological barrier for the face mask area. Use the
disposable biological paper barrier available from Optovue.
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8.3 System Computer Maintenance

To maintain computer performance, Optovue recommends regular use of the Disk
Cleanup and Disk Defragmenter tools. To access these tools, from the computer
desktop select Start > All Programs > Accessories > System Tools > Disk
Cleanup or Disk Defragmenter. We suggest disk defragmentation monthly, or more
frequently if the system is used heavily.

Optovue suggests major maintenance, including calibration verification, be done once a
year. We further suggest to close the system application when the system has not been
in use for a long period of time, and to shut down the system at the end of each
business day.

8.4 Network Connections

The system connects to the network with an Ethernet cable. You must not change
settings for the Local Area Connection; if they are changed, the system will no longer be
able to connect. The IP address for the Local Area Connection is static in order to
connect. All necessary changes to network settings are to be made in the Local Area
Connection 2 port. (You see only Local Area Connection 2 when you connect the USB
to Ethernet Adapter shipped with the system).

& Network Connections E]@
»

File Edit View Favorites Tools Advanced Help

? /7 Search Folders mv

Address e Network Connections v‘\ E Go
MName Type Status

LAN or High-Speed Internet

[S] Create a new connection Y i 5
— <L, 1394 Connection LAN or High-Speed Internet Connected, Firewalled
% Setup ahome or small

BFfice network AL Local Area Connection LAN or High-Speed Internet Connected, Firewalled
@ Change Windows Firewal <L Local Area Connection 2 LAN or High-Speed Internet Connected, Firewalled
settings M wireless Network Connection LAN or High-Speed Internet Disabled, Firewalled

»

See Also

i) Network Troubleshooter

Other Places S

@ Control Panel
‘4) My Network Places
) My Documents

_J My Computer

Details 2

Network Connections
System Folder

<l

i v

4 objects

Figure 105 Windows™ Network Connections Screen
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0= Note: Do not change the computer name when configuring the system
computer.

End of section

iScan User Manual Page 130 of 181 P/N 580-49328-004 Rev. A



9 Scan Pattern Specifications

9.1 Scan Patterns Table

The table below describes all iVue scan patterns.

Table 2 iVue Scan Patterns

3:;’; Description # A-Scan Adjusytab'"t Default
13 copcent_rlc rings 'at the Concentric lines:
following diameters:
49 mm, 4.6 mm, 4.3 mm >
. 4.0 mm, 3.7 mm, 3.4 mm > ggg ﬁigg:z
Nerve Fiber | 3 1 mm, 2.8 mm, 2.5 mm > Fixed 4.9 mm
ONHscan | 2.2mm, 1.9 mm, 1.6 mm, 1.3 mm 591 A-scans
9' b b T 429 A-scans
- Radial lines: 459
12 radial line scans at 3.4 mm A-scans er. line
length. perll
Raster pattern of 13 horizontal
line scans (6 mm long & 512 A-
scans each). An additional 7 13 lines: 512
Retina Map horizontal line scans (1024 A- A-scans Fixed 6 mmx6
scans) within central 1.5 mm 7 lines: 1024 mm
scan vertical zone. Each horizontal line | A-scans
scan sampled 5 or more times &
averaged.
2x 1024 .
Retina Cross line scan with speckle (24 scans in each ?ggcl,e.(é)oto gorr;r: dat
c Li elimination process direction are then incre’ment) 90°
ross Line averaged)
Cornea 8 radial line scans at 6 mm length. 7 lines: 1(.)24
Horizontal line scanned eight A-scansfline Fixed 6 mm
Pachymetry | .. . 1 line: 1024 diameter
times for averaging ;
scan A-scans/line x 8
8 radial line scans at 6 mm length. 7 lines: 1924
rrr Horizontal line scanned eight A-scans/line Fixed 6 mm
Lens Fitting | .. . 1 line: 1024 diameter
times for averaging ;
A-scans/line x 8
1x1024 Angle: 0 to
Cornea Single line scan with speckle (16 scans 188° '(50 5 mm at
Anal elimination process averaged to a incre,ment) 90°
ngle single line scan)
128 frames equally spaced 128x512 6 mm x 6
: B-scans to cover a square volume | (65,536 data Fixed
Retina 3D . X mm
center fixation points)
) 128 frames equally spaced 128x512 6 mm x 6
Nerve Fiber | B_scans to cover a square volume (65,536 data Fixed mm
3D Disc fixation at 20° nasal points)

iScan User Manual
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ﬁ can Description # A-Scan QoiEseel Default
ame y
1 horizontal line with 7 mm scan
length, followed by 15 vertical
Nerve Fiber | lines with 7 mm scan length & 0.5 | 1x934 (horizontal) | . 4 7mmx7
GCC M mm interval, centered 1 mm 15x934 (vertical) mm
ap temporal to fovea
1 horizontal line with 7 mm scan
length, followed by 17 vertical 1% 937
lines with 7 mm scan length & 0.5 17 x 937
mm interval, centered 1 mm 7 x (1024+32) (5 . 7 mm x 8
- temporal to fovea. Fixed
iWellness . scans averaged) mm
8 HD scans - 7 horizontal scans
. . X 1x(1024+32) (5
with 0.25 mm interval covering
) scans averaged)
central 1.5 mm, 1 vertical scan.
Each HD scan averaged 5 times
141 frames equally spaced 8mm x
3D Fundus | B-scans to cover a square volume | 385x141 Fixed
- 8mm
En Face center fixation

9.2 Scan Orientation Convention

¢ Nerve Fiber ONH scan: First line from the 6:00 position to 12:00 then rotate the
lines clockwise.

¢ Retina Map scan: 13 (6 mm long) horizontal lines plus 7 (6 mm long) horizontal
lines within central 1.5 mm vertical zone

e Cross Line scan: 1 horizontal line plus 1 vertical line. Each line has 12 scans
averaged.

e Pachymetry (Cornea) scan: 8 radial lines scans, 1024 A-scans each.

¢ Angle (Cornea) scan: 1 horizontal line scan averaged 16 times.

iScan User Manual
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9.2.1 Nerve Fiber ONH scan
Objective: Measure the RNFL thickness and optic disc.

Description: 12 radial lines with 3.4 mm scan length, followed by 13 concentric rings,
all centered on optic disc.

Figure 106 Nerve Fiber ONH Scan Pattern
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9.2.2 Retina Map Scan
Objective: Measure the macular retinal thickness map.

Description: 6 x 6 mm raster centered on fixation. The raster spacing is 0.25 mm in the
inner 1.5 x 6 mm area and 0.5 mm in the outer area.

Figure 107 Macular Raster 6x6 (Retina) Scan Pattern
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9.2.3 Cornea Pachymetry Scan
Objective: Measure the corneal thickness and map it.

Description: Pachymetry Map: 8 radial line scans with 1024 A-scans each. Horizontal
line scan is captured 8 times and then averaged.

Horizontal scan presentation is the averaged result only.

Figure 108 Pachymetry 6 mm Diameter (Cornea) Scan Pattern
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9.2.4 iWellness Scan

Objective: Measure the inner retinal thickness map and total retinal thickness map for
retina.

Description: 1 horizontal line with 7mm scan length, followed by 17 vertical lines with
7mm scan length and 0.5mm interval, centered 1mm temporal to fovea. 8 HD scans - 7
horizontal scans with 0.25mm interval covering central 1.5mm, 1 vertical scan. Each HD
scan is averaged 5 times.

Figure 109 iWellness Scan Pattern
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9.3 Fixation Patterns

0=5 Note: The fixation patterns shown below replace the LED patterns in previous
models.

9.3.1 Retina Scan Fixation Pattern

All retinal scans(Retina Map, Cross Line, and 3D) use the same fixation. The patient
should fixate on the X in the center of the pattern. If the patient cannot see the center X
due to pathology, they should look to the edges of the pattern and follow the lines
inward and fixate where they cross centrally.

9.3.2 Nerve Fiber ONH and 3D Optic Nerve Scan Fixation Pattern
The Nerve Fiber ONH and 3D Disc fixation pattern is a green cross, located nasally.

Ts

9.3.3 GCC Map Scan and iWellness Fixation Pattern

The fixation pattern for GCC Map and iWellness scans is a green cross, located
temporally 1 mm from the center.

T;
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9.3.4 Cornea Scan Fixation Pattern
The cornea fixation pattern is a large green X located directly in the center.

End of section
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10 Technical Specifications

10.1 System Specifications

10.1.1 Scanner
¢ OCT Image Acquisition Rate: 25,000 A-scan/second
e Frame Rate: 256 to 1024 A-scan/frame
e Optical Resolution: (in tissue)
e Depth: 5 um
e Transverse resolution 15 ym (retina)
¢ Image Sampling Rate:
e Transverse: 8 um nominal (4 um to 40 ym)
e Scan Range:
o Depth: 2 0or 2.3 mm

e Transverse: 2 mm to 12 mm

Scan Beam Wavelength: 830 nm to 850 nm

Exposure Power at pupil: 700 pW to 750 yW

10.1.2 Iris Imager
e FOV: Approximately 13 mm (H) x 8 mm (V)
¢ Image sensor: 752 x 480 pixels, 1/3 in. monochrome CMOS sensor
¢ NIR lllumination: 735 nm LED

10.1.3 Cornea Imager
e Cornea FOV: 10 £1 mm x 8 £1 mm
¢ Image sensor 1/3” wide VGA
e NIR lllumination: 735 nm LED

10.1.4 Patient Interface
e Working Distance: 21.2 mm for retina, 16.6 mm for cornea
e Motorized Focus Range: -15D to +10 D
e controlled X-Y-Z adjustment: X-90 m, Y-80 mm, Z-30 mm
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10.1.5 Computer Unit
e Screen Size and Resolution: 14.1 in. or 15.4 in., 1280 x 800
e CPU: Intel Core2 Duo
e Memory: 22 GB
e Hard disk: > 300 GB
e |/O ports: at least three USB 2.0 ports; one 1394 port
¢ Networking: Intel Gigabit Ethernet chipset
e Operating system: 32 or 64 Windows XP Pro. Ed./Win 7

10.1.6 Power
e Power Input: AC100-240V, 50/60 Hz
e Current: 1.6 AMPS
e Power Rating: 75W

10.1.7 Compliance
e General Medical IEC/ BS EN 60601-1
e Medical System IEC/ EN 60601-1-1
e EMC of Medical System |IEC/ EN 60601-1-2

General requirements for basic safety and essential performance. IEC/ BS EN 62366-1.

10.1.8 Fuse (Base Unit)
e Rating: 3.15A/250VAC
e Package: 5 mm x20 mm

e Type: Slow blow

10.1.9 Environmental Specifications

Operating Conditions:
e Temperature: 10 — 35°C
¢ Relative Humidity: 30 — 90%
e Atmospheric pressure: 800 — 1060 hPa
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Storage Conditions:

Temperature: -10 — 55°C
Relative Humidity: 10 — 95%
Atmospheric pressure: 700 — 1060 hPa

Transport Conditions

10.1.10

Temperature: -40 — 70°C

Relative Humidity: 10 — 95%
Atmospheric pressure: 500 -1060 hPa
Vibration, Sinusoidal: 10 — 500Hz, 0.5g
Shock: 30g, duration 6ms

Bump: 10g, duration 6ms

Electrical supply: Class 1
Installation category: Il

Pollution degree: 2

End of section
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11 Appendices

11.1 Appendix A: Normative Database

Using the iVue 100 system on a study population deemed representative of the normal
population, Optovue established a normative database (NDB) for measurements of
retinal thickness, GCC thickness, RNFL thickness, and optic nerve parameters. The
normative database comprises 458 qualified normal subjects out of an initial enroliment
of 521 subjects. The final normative database includes at least 442 normal subjects with
one or more qualified scans per subject for the four scan types: nerve fiber ONH scan
(449 normal subjects), GCC map scan (451 normal subjects), and Retina Map scan
(452 normal subjects).

The iVue 100 normative database consists of:
e 46.9% Caucasian descent,
e 18.6% Asian,
e 10.0% African,
e 15.3% Hispanic,
e 7.9% Indian, and
e 1.4% Other.

The iVue 100 NDB covers the age range of 18 to 82 years, refractive error (spherical
equivalent) range of -8.63D to +6.00D, IOP range of 8.0 to 21.0 mmHg, and CCT range
of 350 um to ~ 666 ym. The gender ratio of the database is 39.5% male to 60.5%
female.

The retina thickness measurements, the RNFL thickness measurements, the GCC
thickness measurement, and the optic nerve head parameters of the normal subjects
from the iVue 100 NDB study are similar to the normal values reported before with OCT
devices. The mean +SD from the iVue 100 NDB study for the central fovea retinal
thickness was 261.4 ym £19.3 pm, for the average RNFL thickness was 99.1 um + 9.5
pum, and for the average GCC thickness was 93.9 ym + 6.8 ym.

The iVue 100 NDB study found that age was significantly associated with most study
parameters, but the effect of age was small. The iVue 100 NDB study found that SQl
was significantly associated with most study parameters; the effect was small and at
similar level to the age effect. The RNFL and ONH parameters were found to have
strong association with disc area.

The standard deviation values of repeatability and reproducibility of selected iVue 100
measurement parameters based on the normative database study.
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The normative database includes data for both retina and nerve fiber (Optic Disc,
RNFL, and Ganglion Cell Complex). The NDB parameters were adjusted by the
following factors:

e Age (retina and nerve fiber maps)
e Optic Disc size (only in conjunction with the ONH scan)

e Gender (Retina only)

The normative database coloring indicates where the patient’'s measurements fall within
the range of the “normal” population range for their age group. The color coding for the
normative display uses green (within normal range), yellow (borderline normal range)
and red (outside normal range).

=5 Note: The ETDRS thickness and NDB results are affected by the positioning of
the foveal indicator (yellow dot on Retina Map thickness display). If the
fovea is not in the center of the scan, you can move it manually by simply
dragging and dropping the yellow dot, and selecting Yes at the prompt to
reprocess.

11.1.1 Color Legend for NDB References

For GCC, ONH Analysis, TSNIT, and RNFL Thickness, the Percentile Color Legend
represents: > 5% for Within Normal (green), < 5% and > 1% for Borderline (yellow) and
< 1% for Outside Normal (red). For GLV, FLV, Optic disc C/D and Cup, the Percentile
Color Legend represents: < 95% is Within Normal (green), > 95% and < 99% for
Borderline (yellow), and > 99% for Outside Normal (red).

GCC, RNFL, TSNIT, ONH Analysis

Within Normal
Borderline

Retina Map

> 95% Borderline

5-95% Normal
< 5% Borderline
< 1% Outside Normal

Figure 110 Posterior Thickness Percentile Color Legend

End of section
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11.2 Appendix B: Precision Data for iVue 100 with NDB

A new repeatability and reproducibility study was conducted with IRB approval to
assess iVue precision. Fourteen (14) normal subjects, thirteen (13) patients with
glaucoma, and thirteen (13) patients with retina disease were included in the study to
evaluate the repeatability and reproducibility of iVue 100 measurements.

Only one eye per subject was included in the study. Each study eye was imaged 3
times with each of the scan patterns (ONH, Retina, GCC, iWellness) per iVue 100

instrument and imaged across three instrument/operator pairs. The three iVue 100
instruments were operated by different operators, therefore, the combined effect of
machine and operator was estimated for measurement reproducibility.

Subject enrollment criteria were as follows:

Normal Subjects
e Atleast 18 years of age
e Able and willing to provide consent

¢ Able and willing to complete the required examinations

Exclusion Criteria
¢ History of ocular diseases
o History of ocular surgery except laser refractive surgery

e Pathological findings in fundus based on ophthalmoscopic examination

Glaucoma and Retinal Subjects

Inclusion Criteria

e Atleast 18 years of age

e Able and willing to provide consent

¢ Able and willing to complete the required examinations and visits

¢ Refractive error within +/- 8 diopters sphere and within +/- 2.5 diopters cylinder in
study eye

e Best corrected visual acuity equal or better than 20/100

e Glaucoma subjects have clinical exam results consistent with glaucoma, either
with glaucomatous visual field defect (e.g. PSD < 5%, and/or a GHT Outside

Normal Limits) or structural damage consistent with glaucoma (e.g. neuroretinal
rim thinning, notching, and RNFL defect)
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¢ Retina subjects have clinical exam results consistent with retinal pathologies
such as drusen, Geographic Atrophy (GA), wet AMD, diabetic retinopathy (DR),
diabetic macular edema (DME), epiretinal membranes (ERM), and macular hole,
etc.

Exclusion Criteria

e Other ocular pathologies except glaucoma and/or retinal pathologies.

The precision of iVue 100 measurements was estimated for all parameters measured
and discussed in Section 4.7 (15 retinal parameters from the Retina scan, 5 GCC
parameters from the GCC scan, 15 Retinal Nerve Fiber Layer (RNFL) parameters from
ONH scan, 9 optic disc parameters from ONH scan, 11 retinal parameters from the
iWellness scan, and 5 GCC parameters from the iWellness scan).

The precision for each iVue 100 parameter is provided for the normal eyes, the retinal
disease eyes, and the glaucoma eyes respectively as follow: repeatability standard
deviation (SD), reproducibility SD, coefficient of variation (COV) based on reproducibility
(Reproducibility SD/Mean*100), and 95% limits of reproducibility (2.8*Reproducibility
SD).

11.2.1 Retina Scan
Table 1. Repeatability and Reproducibility of Retina Thickness (Normal Eyes)

Normal Eyes (14 subjects, 125 scans)
Retina Scan
o Repeatability | Reproducibility | Reproducibility Reproducibility
ean
(SD) (SD) (cov) (Limit*)

Fovea (um) 255.9 2.27 2.35 0.92% 6.5
ParaFovea (um) 313.2 3.16 3.29 1.05% 9.1
Para S Hemisphere (um) | 314.5 3.95 4.11 1.31% 11.4
Para | Hemisphere (um) 311.9 3.12 3.21 1.03% 8.9
Para Tempo (um) 307.5 3.22 3.35 1.09% 9.3
Para Superior (um) 315.1 4.54 4.75 1.51% 13.2
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Normal Eyes (14 subjects, 125 scans)
Retina Scan
- Repeatability | Reproducibility | Reproducibility Reproducibility
(SD) (SD) (cov) (Limit*)

Para Nasal (um) 320.5 4.35 4.36 1.36% 12.1
Para Inferior (um) 309.9 3.33 3.43 1.11% 9.5
Perifovea (um) 284.2 2.47 2.64 0.93% 7.3
Peri S Hemisphere (um) 288.0 331 3.40 1.18% 9.4
Peri | Hemisphere (um) 280.4 2.90 3.07 1.09% 8.5
Peri Tempo (um) 275.2 2.73 3.03 1.10% 8.4
Peri Superior (um) 287.0 4.20 4.28 1.49% 11.9
Peri Nasal (um) 301.0 3.82 3.82 1.27% 10.6
Peri Inferior (um) 273.7 3.39 3.55 1.30% 9.9

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.
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Table 2. Repeatability and Reproducibility of Retina Thickness (Retina Disease Eyes)

Retinal Disease Eyes (13 subjects, 109 scans)
Retina Scan
S Repeatability | Reproducibility Reproducibility Reproducibility
(SD) (SD) (cov) (Limit*)

Fovea (um) 284.4 3.41 3.49 1.24% 9.7
ParaFovea (um) 312.0 2.60 2.83 0.91% 7.8
Para S Hemisphere (um)| 312.8 4,01 4.28 1.37% 11.9
Para | Hemisphere (um) | 311.3 2.80 2.94 0.95% 8.2
Para Tempo (um) 302.9 6.78 6.83 2.26% 18.9
Para Superior (um) 312.7 5.49 5.75 1.84% 15.9
Para Nasal (um) 3211 6.56 6.56 2.05% 18.2
Para Inferior (um) 311.4 3.54 3.68 1.19% 10.2
Perifovea (um) 279.4 2.03 2.04 0.73% 5.7
Peri S Hemisphere (um) | 282.5 3.09 3.09 1.10% 8.6
Peri | Hemisphere (um) 276.2 4.15 4.17 1.51% 11.6
Peri Tempo (um) 267.3 3.76 3.80 1.42% 10.5
Peri Superior (um) 282.7 4.14 4.14 1.47% 11.5
Peri Nasal (um) 295.1 3.57 3.57 1.21% 9.9
Peri Inferior (um) 272.4 5.94 5.94 2.19% 16.5

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.
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Table 3. Repeatability and Reproducibility of Retina Thickness (Glaucoma Eyes)

Glaucoma Eyes (13 subjects, 101 scans)
Retina Scan
R Repeatability | Reproducibility Reproducibility Reproducibility
(SD) (SD) (cov) (Limit*)

Fovea (um) 251.7 2.74 2.97 1.17% 8.2
ParaFovea (um) 293.4 2.14 2.33 0.79% 6.4
Para S Hemisphere (um) | 294.1 2.55 2.74 0.93% 7.6
Para | Hemisphere (um) | 292.8 2.58 2.68 0.91% 7.4
Para Tempo (um) 288.6 2.51 2.79 0.96% 7.7
Para Superior (um) 294.0 2.99 3.20 1.08% 8.9
Para Nasal (pm) 299.6 2.78 2.80 0.93% 7.8
Para Inferior (um) 291.5 2.95 3.03 1.03% 8.4
Perifovea (um) 266.1 1.71 2.03 0.76% 5.6
Peri S Hemisphere (um) | 270.4 2.93 3.29 1.21% 9.1
Peri | Hemisphere (um) | 261.8 3.42 3.53 1.34% 9.8
Peri Tempo (um) 260.6 2.62 2.87 1.09% 7.9
Peri Superior (um) 269.4 3.77 4.17 1.55% 11.6
Peri Nasal (um) 278.7 2.84 2.90 1.04% 8.0
Peri Inferior (um) 255.6 4.43 4.56 1.78% 12.6

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.
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11.2.2 GCC Scan
Table 4. Repeatability and Reproducibility of GCC (Normal Eyes))

Normal Eyes (14 subjects, 124 scans)
GCC Scan
o Repeatability | Reproducibility Reproducibility Reproducibility
ean
(SD) (SD) (cov) (Limit*)

GCC_Average (um) 97.5 13 1.3 1.32% 3.6
GCC_Superior_Avg (um) | 97.0 1.4 1.4 1.40% 3.8
GCC_lInferior_Avg (um) | 98.1 1.3 1.3 1.37% 3.7
GCC_FLV (%) 0.742 0.197 0.197 26.67% 0.546
GCC_GLV (%) 3.220 0.730 0.730 22.80% 2.022

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.

** The high COV values for GCC_FLV and GCC_GLYV is due to the highly skewed distribution near zero values of
normal eyes and the denominator for the COV calculation has a low value. COV is not an appropriate measure of
test-retest variability for such skewed distributions with a large portion of data at or near zero. Interpret the data with
this information in mind.

Table 5. Repeatability and Reproducibility of GCC (Retina Disease Eyes)

Retinal Disease Eyes (13 subjects, 98 scans)
GCC Scan
o Repeatability | Reproducibility | Reproducibility Reproducibility
ean
(SD) (SD) (cov) (Limit*)

GCC_Average (um) 98.6 1.4 1.4 1.39% 3.8
GCC_Superior_Avg (um) 99.0 1.6 1.6 1.59% 4.4
GCC_Inferior_Avg (um) 98.1 1.5 1.5 1.56% 4.2
GCC_FLV (%) 1.790 0.746 0.746 41.79% 2.067
GCC_GLV (%) 3.072 0.940 0.940 29.01% 2.606

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
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Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.

** The high COV values for GCC_FLV and GCC_GLYV is due to the highly skewed distribution near zero values of
normal eyes and the denominator for the COV calculation has a low value. COV is not an appropriate measure of
test-retest variability for such skewed distributions with a large portion of data at or near zero. Interpret the data with
this information in mind.

Table 6. Repeatability and Reproducibility of GCC (Glaucoma Eyes)

Glaucoma Eyes (13 subjects, 109 scans)
GCC Scan
o Repeatability | Reproducibility | Reproducibility Reproducibility
ean
(SD) (SD) (cov) (Limit*)

GCC_Average (um) 85.7 1.1 1.2 1.39% 33
GCC_Superior_Avg (um) | 86.2 14 1.5 1.80% 4.3
GCC_Inferior_Avg (um) 85.2 1.2 1.3 1.53% 3.6
GCC_FLV (%) 3.604 0.539 0.579 16.58% 1.605
GCC_GLV (%) 11.673 0.936 0.999 8.65% 2.770

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.

** The high COV values for GCC_FLV and GCC_GLYV is due to the highly skewed distribution near zero values of
normal eyes and the denominator for the COV calculation has a low value. COV is not an appropriate measure of
test-retest variability for such skewed distributions with a large portion of data at or near zero. Interpret the data with
this information in mind.

11.2.3 iWellness

Note that 11 retina thickness parameters are provided for iWWellness scan retinal
measurements; the four hemisphere parameters (Para S Hemisphere, Para |
Hemisphere, Peri S Hemisphere, and Peri | Hemisphere) are not included in the
iWellness scan report.

Table 7. Repeatability and Reproducibility of GCC and Retina Thickness (Normal Eyes)

Normal Eyes (14 subjects, 125 scans)

iWellness Scan
Repeatability | Reproducibility | Reproducibility Reproducibility

(sD) (sp) (cov) (Limit*)

Mean

GCC Parameters
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iWellness Scan

Normal Eyes (14 subjects, 125 scans)

Mean

Repeatability

Reproducibility

Reproducibility

Reproducibility

(SD) (SD) (cov) (Limit*)
GCC_Average (um) 97.2 0.9 0.9 0.97% 2.6
GCC_Superior_Avg (um) 96.6 11 1.1 1.12% 3.0
GCC_Inferior_Avg (um) 97.8 0.9 0.9 0.97% 2.6
GCC_FLV (%) 0.737 0.149 0.151 20.36% 0.417
GCC_GLV (%) 3.095 0.428 0.428 13.79% 1.187
Retina Parameters
Fovea (um) 257.4 2.6 3.1 1.22% 8.7
ParaFovea (um) 315.1 3.6 3.7 1.17% 10.3
Para S Hemisphere (um) | 316.1 4.2 4.2 1.33% 11.7
Para | Hemisphere (um) 314.1 3.7 3.8 1.21% 10.5
Para Tempo (um) 304.8 3.8 4.0 1.30% 11.0
Para Superior (um) 319.8 4.6 4.6 1.45% 12.8
Para Nasal (um) 320.2 5.1 5.1 1.59% 14.1
Para Inferior (um) 315.6 3.9 4.1 1.30% 11.4
Perifovea (um) 285.9 2.7 2.8 0.97% 7.7
Peri S Hemisphere (um) 289.6 3.7 3.7 1.27% 10.2
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Normal Eyes (14 subjects, 125 scans)
iWellness Scan
o Repeatability | Reproducibility | Reproducibility Reproducibility
ean
(SD) (SD) (cov) (Limit*)

Peri | Hemisphere (um) 282.2 2.9 2.9 1.03% 8.1
Peri Tempo (um) 279.8 4.5 4.6 1.66% 12.9
Peri Superior (um) 289.2 4.3 4.4 1.51% 12.1
Peri Nasal (um) 299.3 4.4 4.4 1.48% 123
Peri Inferior (um) 275.3 33 3.4 1.22% 9.3

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.

** The high COV values for GCC_FLV and GCC_GLYV is due to the highly skewed distribution near zero values of
normal eyes and the denominator for the COV calculation has a low value. COV is not an appropriate measure of
test-retest variability for such skewed distributions with a large portion of data at or near zero. Interpret the data with
this information in mind.

Table 8. Repeatability and Reproducibility of GCC and Retina Thickness (Retina Disease

Eyes)

Retinal Disease Eyes (13 subjects, 108 scans)

iWellness Scan
o Repeatability | Reproducibility Reproducibility Reproducibility
ean
(SD) (SD) (cov) (Limit*)

GCC Parameters
GCC_Average (um) 98.7 1.3 1.4 1.38% 3.8
GCC_Superior_Avg (um) | 98.7 1.6 1.7 1.71% 4.7
GCC_Inferior_Avg (um) | 98.6 1.5 1.5 1.50% 4.1
GCC_FLV (%) 1.851 0.504 0.508 28.64% 1.408
GCC_GLV (%) 3.111 0.671 0.690 22.59% 1.912
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Retinal Disease Eyes (13 subjects, 108 scans)
iWellness Scan
- Repeatability | Reproducibility Reproducibility Reproducibility
(SD) (SD) (cov) (Limit*)
Retina Parameters

Fovea (um) 281.7 3.1 3.6 1.29% 10.1
ParaFovea (um) 313.2 2.6 2.6 0.84% 7.3
Para S Hemisphere (pm) | 314.1 3.2 3.2 1.02% 8.9
Para | Hemisphere (um) | 312.3 2.6 2.6 0.83% 7.2
Para Tempo (um) 303.9 3.9 4.2 1.38% 11.6
Para Superior (um) 316.1 3.7 3.8 1.20% 10.5
Para Nasal (um) 319.1 4.7 4.8 1.51% 13.3
Para Inferior (um) 313.7 3.2 3.2 1.01% 8.8
Perifovea (um) 280.3 1.7 19 0.67% 5.2
Peri S Hemisphere (um) | 283.7 2.0 2.0 0.72% 5.7
Peri | Hemisphere (um) | 276.8 2.2 2.6 0.94% 7.2
Peri Tempo (um) 272.0 3.9 4.2 1.54% 11.6
Peri Superior (um) 284.0 2.4 24 0.85% 6.7
Peri Nasal (um) 292.7 2.6 2.6 0.89% 7.2
Peri Inferior (um) 272.3 2.6 3.1 1.14% 8.6

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.
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** The high COV values for GCC_FLV and GCC_GLYV is due to the highly skewed distribution near zero values of
normal eyes and the denominator for the COV calculation has a low value. COV is not an appropriate measure of
test-retest variability for such skewed distributions with a large portion of data at or near zero. Interpret the data with

this information in mind.

Table 9. Repeatability and Reproducibility of GCC and Retina Thickness (Glaucoma Eyes)

iWellness Scan

Glaucoma Eyes (13 subjects, 106 scans)

Repeatability

Reproducibility

Reproducibility

Reproducibility

Mean (D) (D) (CoV) (Limit*)
GCC Parameters
GCC_Average (um) 85.3 0.8 0.8 0.91% 2.2
GCC_Superior_Avg (um) 85.6 1.0 1.0 1.11% 2.7
GCC_Inferior_Avg (um) 85.0 11 1.1 1.28% 3.0
GCC_FLV (%) 3.521 0.354 0.375 10.68% 1.040
GCC_GLV (%) 11.644 0.606 0.606 5.32% 1.680
Retina Parameters
Fovea (um) 253.4 2.7 3.0 1.18% 8.3
ParaFovea (um) 295.1 2.4 2.5 0.83% 6.8
Para S Hemisphere (um) 295.6 2.9 2.9 0.98% 8.1
Para | Hemisphere (um) 294.7 2.7 2.7 0.93% 7.6
Para Tempo (um) 288.4 2.7 2.8 0.97% 7.8
Para Superior (um) 297.7 3.0 31 1.02% 8.5
Para Nasal (um) 298.3 3.6 3.6 1.20% 10.0
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Para Inferior (um) 296.2 2.9 2.9 0.98% 8.1
Perifovea (um) 266.4 1.6 1.7 0.65% 4.8
Peri S Hemisphere (um) 270.7 2.1 2.1 0.78% 5.9
Peri | Hemisphere (um) 262.1 2.4 2.6 1.00% 7.3
Peri Tempo (um) 263.2 4.0 4.1 1.55% 11.3
Peri Superior (um) 269.5 2.4 2.4 0.90% 6.7
Peri Nasal (um) 276.9 3.0 3.0 1.07% 8.2
Peri Inferior (um) 256.0 2.3 2.7 1.04% 7.4

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.

** The high COV values for GCC_FLV and GCC_GLYV is due to the highly skewed distribution near zero values of
normal eyes and the denominator for the COV calculation has a low value. COV is not an appropriate measure of
test-retest variability for such skewed distributions with a large portion of data at or near zero. Interpret the data with
this information in mind.

11.2.4 ONH Scan
Table 10. Repeatability and Reproducibility of Disc and RNFL Thickness (Normal Eyes)

Normal Eyes (14 subjects, 123 scans)
ONH Scan
o Repeatability | Reproducibility | Reproducibility | Reproducibility
ean
(SD) (SD) (cov) (Limit*)
Disc Parameters

disc Area (mm?) 2.141 0.084 0.093 4.33% 0.258
Area_C_D_ratio 0.286 0.020 0.021 7.25% 0.057
H_C_D_ratio 0.576 0.041 0.041 7.22% 0.115
V_C_D_ratio 0.470 0.035 0.036 7.62% 0.099
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Normal Eyes (14 subjects, 123 scans)
ONH Scan
- Repeatability | Reproducibility | Reproducibility | Reproducibility
(SD) (SD) (cov) (Limit*)
Cup Area (mm?) 0.625 0.042 0.043 6.94% 0.120
Rim Area (mm?) 1.516 0.079 0.087 5.72% 0.242
Rim Volume (mm?3) 0.176 0.014 0.015 8.34% 0.041
Nervehead_Volume (mm?3) | 0.352 0.047 0.049 13.89% 0.137
Cup Volume (mm?3) 0.136 0.024 0.025 18.81% 0.070
RNFL Parameters

Avg_RNFL (um) 97.9 1.4 1.5 1.56% 4.2
Sup_RNFL (um) 100.6 1.7 1.7 1.67% 4.7
Inf_RNFL (um) 95.3 1.9 2.2 2.35% 6.2
Tempo (um) 70.9 2.3 2.3 3.27% 6.4
Superior (um) 120.7 2.8 2.8 2.34% 7.8
Nasal (um) 77.1 2.7 2.7 3.46% 7.4
Inferior (um) 123.2 3.6 3.9 3.15% 10.7
TU (um) 77.2 3.2 3.2 4.17% 8.9
ST (um) 136.7 3.9 3.9 2.85% 10.8
SN (um) 104.7 4.2 4.2 4.03% 11.7
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Normal Eyes (14 subjects, 123 scans)
ONH Scan
o Repeatability | Reproducibility | Reproducibility | Reproducibility
ean
(SD) (SD) (cov) (Limit*)

NU (um) 83.7 3.5 3.5 4.14% 9.6
NL (pum) 70.4 2.9 3.0 4.22% 8.3
IN (um) 109.0 4.4 4.6 4.20% 12.7
IT (um) 137.3 5.3 5.5 4.03% 15.3
TL (um) 64.6 2.5 2.6 3.99% 7.1

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.

Table 11. Repeatability and Reproducibility of Disc and RNFL Thickness (Retinal Disease

Eyes)

Retinal Disease Eyes (13 subjects, 101 scans)

ONH Scan
o Repeatability | Reproducibility | Reproducibility | Reproducibility
ean
(SD) (SD) (cov) (Limit*)

Disc Parameters
disc Area (mm?) 2.417 0.118 0.118 4.99% 0.328
Area_C_D_ratio 0.322 0.023 0.026 7.90% 0.073
H_C_D_ratio 0.592 0.051 0.051 8.41% 0.141
V_C_D_ratio 0.512 0.057 0.062 11.85% 0.172
Cup Area (mm?) 0.814 0.052 0.055 6.69% 0.151
Rim Area (mm?) 1.603 0.111 0.115 7.37% 0.318
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Retinal Disease Eyes (13 subjects, 101 scans)
ONH Scan
- Repeatability | Reproducibility | Reproducibility | Reproducibility
(SD) (SD) (cov) (Limit*)
Rim Volume (mm?3) 0.155 0.015 0.015 10.01% 0.041
Nervehead_Volume (mm3) | 0.339 0.036 0.036 11.20% 0.101
Cup Volume (mm?3) 0.147 0.022 0.023 15.49% 0.063
RNFL Parameters

Avg_RNFL (um) 99.5 1.5 1.9 1.94% 5.3
Sup_RNFL (um) 101.2 2.0 2.5 2.49% 6.8
Inf_RNFL (um) 97.8 2.0 2.2 2.24% 6.0
Tempo (um) 73.1 3.5 3.7 5.17% 10.4
Superior (pm) 119.2 3.6 4.0 3.43% 11.1
Nasal (um) 80.1 3.7 3.7 4.74% 10.3
Inferior (um) 125.5 3.1 3.3 2.64% 9.0
TU (um) 81.2 4.8 5.6 6.93% 15.4
ST (um) 129.4 55 6.0 4.73% 16.6
SN (um) 109.1 4.9 4.9 4.58% 13.7
NU (um) 84.9 4.6 4.6 5.56% 12.7
NL (um) 75.2 3.7 3.7 5.01% 104

iScan User Manual Page 158 of 181 P/N 580-49328-004 Rev. A



Retinal Disease Eyes (13 subjects, 101 scans)
ONH Scan
o Repeatability | Reproducibility | Reproducibility | Reproducibility
ean
(SD) (SD) (cov) (Limit*)

IN (um) 122.7 4.7 4.8 4.05% 133
IT (um) 128.3 4.5 4.6 3.60% 12.8
TL (um) 65.1 3.7 3.7 5.80% 104

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions. Reproducibility
Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.

Table 12. Repeatability and Reproducibility of Disc and RNFL Thickness (Glaucoma
Eyes)

Glaucoma Eyes (13 subjects, 112 scans)

ONH Scan
- Repeatability | Reproducibility | Reproducibility | Reproducibility
(SD) (SD) (cov) (Limit*)
Disc Parameters

disc Area (mm?) 2.513 0.072 0.105 4.15% 0.291
Area_C_D_ratio 0.564 0.022 0.023 4.07% 0.064
H_C_D_ratio 0.794 0.021 0.021 2.66% 0.058
V_C_D_ratio 0.736 0.035 0.036 4.88% 0.099
Cup Area (mm?) 1.473 0.051 0.055 3.72% 0.152
Rim Area (mm?) 1.040 0.082 0.098 9.29% 0.271
Rim Volume (mm?3) 0.062 0.012 0.012 18.75% 0.032
Nervehead_Volume (mm?) | 0.152 0.030 0.030 19.66% 0.084
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Glaucoma Eyes (13 subjects, 112 scans)
ONH Scan
e Repeatability | Reproducibility | Reproducibility | Reproducibility
(SD) (SD) (cov) (Limit*)
Cup Volume (mm?3) 0.465 0.047 0.057 12.29% 0.159
RNFL Parameters

Avg_RNFL (um) 84.6 1.3 1.4 1.70% 4.0
Sup_RNFL (um) 90.2 1.9 1.9 2.11% 5.3
Inf_RNFL (um) 79.0 1.9 2.0 2.51% 5.5
Tempo (um) 65.2 33 34 5.28% 9.5
Superior (um) 108.5 3.0 3.0 2.81% 8.4
Nasal (um) 66.6 2.5 2.6 3.93% 7.2
Inferior (um) 98.3 2.7 2.8 2.88% 7.9
TU (um) 69.8 43 4.6 6.68% 12.9
ST (um) 121.1 4.7 4.9 4.01% 13.5
SN (um) 95.9 4.1 4.1 4.24% 11.3
NU (um) 74.2 3.9 4.1 5.56% 11.4
NL (pum) 58.9 2.6 2.6 4.49% 7.3
IN (um) 88.9 3.7 3.7 4.17% 10.4
IT (um) 107.8 4.9 4.9 4.59% 13.7
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Glaucoma Eyes (13 subjects, 112 scans)

ONH Scan
o Repeatability | Reproducibility | Reproducibility | Reproducibility
ean
(SD) (SD) (cov) (Limit*)
TL (um) 60.6 4.6 4.6 7.67% 12.8

* Reproducibility Limit is the 95% limit for the difference between measurements under the reproducibility conditions.
Reproducibility Limit = 2.8 x Reproducibility SD per ISO 5725-1 and ISO 5725-6.

End of section
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11.3 Appendix C: Scan Quality Index

For the iVue, a Scan Quality Index classification is provided for each scan type,
resulting in a “Good” or “Poor” classification. If the iVue 100 scan classification is “Poor,”
it is deemed unacceptable and unusable. These scans should not be used for clinical
decisions.

The iVue 100 Scan Quality Index (SQlI) is Good or Poor based on the cutoff values for
each scan type in the table below. The SQI value is displayed to the user and is the
same as the Signal Strength Index (SSI) number in RTVue. Optovue made the
nomenclature change from SSI to SQI to better reflect clinical usage of the value. When
the SQlI falls below the cutoff value for the respective scan type, it is labeled “Poor” and
should not be used clinically.

Table 3 Image Quality Classification Based On SQI Cutoffs

sal “Poor”
Retina SQl <40
Glaucoma SQl <27
Cornea SQl <27
GCC SQl <32
iWellness SQl <40

These SQI cutoff values used for iVue 100 were determined based on an in-house
review of a large data set from the iVue, made up of approximately 100 scans with a
wide range of SQI values and including all scan types (retina, glaucoma, cornea, GCC,
iWellness). To establish this cutoff, approximately 100 B scans were reviewed for all 5
scan types on the iVue 100 (cornea, retina, glaucoma, GCC, iWellness). The basic
criteria for review was whether visualization of the critical retinal layers was possible or
not, including the ILM (for all scan types), the RNFL (for glaucoma scans), the IPL (for
retina. GCC, iWellness scans), and the RPE (for retina, iWellness scans). For cornea
scans, the B scans were reviewed to determine if the anterior and posterior cornea
surface could be adequately visualized in order to ascertain accurate segmentation. It
was determined, for each scan pattern, the SQI value where the various retinal or
cornea layers could no longer be visualized in the B scans. These scans cannot be
segmented accurately if there is no ocular structure that can be visualized. Scans with
SQl values below this point would be classified as “Poor.” Once the SQI was strong
enough to reliably provide visualization of the ocular layers, then the scan was
determined to be of “Good” quality.

In order to validate the cutoff between acceptable and not acceptable scans, the
repeatability of scans considered unusable (“Poor”), and scans considered usable
(“Good”), was evaluated by the above classification. For this evaluation, repeat scans
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were performed on six normal subjects with clear ocular media to establish a baseline
precision level. All five scan patterns on the iVue 100 were evaluated and scans in the
same label (“Poor” or “Good”) were used to calculate repeatability defined as the
standard deviation of the thickness values for each measurement. The image quality
was manipulated by defocusing the OCT image during scan acquisition. The defocusing
and resulting lowered image quality emulates the clinical situation which would occur
with media opacity and small pupils. A live feedback bar on image quality was used to
guide the operator to take the images. All measurements were analyzed and the results
are provided in the following tables (numbers are the average standard deviation of the
same label scans averaged across all six subjects). The standard deviation represents
the amount of measurement variability present under different image quality
classifications; the higher the standard deviation, the greater the measurement
variability.

Table 14. Retina Scan Results (Standard Deviation)

Retina
Good Poor
Fovea 2.52 | 9.11
Tempo 3.04 | 12.48
Superior | 4.45 | 8.52
Nasal 6.02 | 12.26
© Inferior 7.44 | 14.72
£ | Tempo1 3.49 | 8.27
& | Superior1 | 3.09 | 4.72
@ | Nasall 5.75 | 9.02
E Inferior1 3.36 | 11.33
Fovea 5.67 | 23.96
Tempo2 | 3.53 | 30.31
Superior2 | 3.26 | 5.15
Nasal2 4.14 | 24.08
Inferior2 | 2.59 | 48.84
Tempo3 | 5.21 | 36.71
© Superior3 | 2.37 | 10.27
% | Nasal3 2.37 | 21.06
® |nferior3 | 5.97 | 33.83
T | Average | 4.13 | 18.04

The table above shows the standard deviation values of the scans with the same image
quality label averaged over all subjects for each retina thickness parameter. The first
column of data shows the results when the image qualities are listed as “Good” and the
scans are deemed acceptable and usable. The second column of data shows the
results when the image qualities are listed as “Poor” and the scans are deemed
unacceptable and not usable. It can be seen that the standard deviations are small
when the image qualities are “Good” and therefore the scans are usable, and the
standard deviations increase when the image qualities are “Poor” and therefore the
scans are unusable.
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From the high variability in the unusable scans, it is recommended that “Poor” scans are
not to be used for clinical decision making due to their poor image quality.

Table 15. Glaucoma Scan Results (Standard Deviation)

Glaucoma Good | Poor
Avg RNFL | 5.16 16.89
Sup RNFL | 4.63 17.58
Inf RNFL 8.67 21.70
Tempo 6.56 12.25
Superior 8.25 17.75
Nasal 12.15 | 37.08
Inferior 9.80 25.80
TU1 6.98 10.45
TU2 7.62 6.86

ST2 8.52 12.35
ST1 1148 | 17.14
SN1 10.77 | 23.79
SN2 8.37 36.23
NU2 13.17 | 40.92
NU1 11.46 | 34.83
NL1 16.29 | 31.85
NL2 19.32 | 44.26
IN2 8.57 34.15
IN1 14.40 | 30.62
IT1 11.63 | 28.55
IT2 12.19 | 26.48
TL2 13.71 | 23.86
TL1 7.50 12.21
Average 10.31 | 24.51

The table above shows the standard deviation values of the scans with the same image
quality label averaged over all subjects for each glaucoma thickness parameter. The
first column of data show the results when the image qualities are listed as “Good” and
the scans are deemed acceptable and usable. The second column of data shows the
results when the image qualities are listed as “Poor” and the scans are deemed
unacceptable and not usable. It can be seen that the standard deviations are small
when the image qualities are “Good” and therefore the scans are usable, and the
standard deviations increase when the image qualities are “Poor” and therefore the
scans are unusable.

From the high variability in the unusable scans, it is recommended that “Poor” scans are
not to be used for clinical decision making due to their poor image quality.

Table 16. Cornea Scan Results (Standard Deviation)

Cornea Good Poor
0-2 mm | V2 mm 142 | 36.23
we | VEmMT | 298 | 66.08

N E | g7 744 [17.78
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Cornea Good | Poor
S 11.18 | 21.57
SN 6.71 | 20.12
N 3.98 | 55.84
IN 3.30 | 22.83
I 3.58 | 20.87
IT 252 | 28.59
V6EmmT | 542 | 57.62
ST2 15.12 | 20.84
S2 17.47 | 17.90

£ | SN2 9.41 | 25.58
£ N2 580 | 1145
W | IN2 6.34 | 24.98
12 5.67 | 20.44
IT2 7.25 | 49.67
Average | 6.80 | 30.49

The table above shows the standard deviation values of the scans with the same image
quality label averaged over all subjects for each Cornea thickness parameter. The first
column of data shows the results when the image qualities are listed as “Good” and the
scans are deemed acceptable and usable. The second column of data shows the
results when the image qualities are listed as “Poor” and the scans are deemed
unacceptable and not usable. It can be seen that the standard deviations are small
when the image quality are “Good” and therefore the scans are usable, and the
standard deviations increase when the image qualities are “Poor” and therefore the
scans are unusable.

From the high variability in the unusable scans, it is recommended that “Poor” scans are
not be used for clinical decision making due to their poor quality.

Table 17. GCC Scan Results (Standard Deviation)

Good Poor
Average 1.819841 | 4.790386
Superior Avg | 2.392628 | 6.685251
Inferior Avi 1.909602 | 4.30937
GCC-FLV 0.562347 | 0.926966
GCC-GLV 0.814944 | 0.804625

The table above shows the standard deviation values of the scans with the same image
quality label averaged over all subjects for each GCC parameter. The first column of
data shows the results when the image qualities are listed as “Good” and the scans are
deemed acceptable and usable. The second column of data shows the results when the
image qualities are listed as “Poor” and the scans are deemed unacceptable and not
usable. It can be seen that the standard deviations are small when the image qualities
are “Good” and therefore the scans are usable, and the standard deviations increase
when the image qualities are “Poor” and therefore the scans are unusable.
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From the high variability in the unusable scans, it is recommended that “Poor” scans are
not to be used for clinical decision making due to their poor quality.

Table 18. iWellness Scan Results (Standard Deviation)
Good Poor

GCC Average 1.613258 | 4.669008

Superior Avg | 1.720426 | 4.55784

Inferior Avg 1.937574 | 5.421068

FLV 0.351951 | 0.654639
GLV 0.833165 | 1.179751
Full Retina | Fovea 9.845381 | 39.86225
Tempo 4.399735 | 25.84062
Superior 5.204816 | 21.2472
Nasal 4.70569 | 18.99658
Inferior 5.067598 | 10.11727
Tempo2 5.246559 | 19.06622

Superior2 4.379145 | 5.422231

Nasal2 3.603066 | 5.056085
Inferior2 4.952697 | 7.333335
Average 3.847219 | 12.10172

The table above shows the standard deviation values of the scans with the same image
quality label averaged over all subjects for each iWellness parameter. The first column
of data shows the results when the image qualities are listed as “Good” and the scans
are deemed acceptable and usable. The second column of data shows the results when
the image qualities are listed as “Poor” and the scans are deemed unacceptable and
not usable. It can be seen that the standard deviations are small when the image
qualities are “Good” and therefore the scans are usable, and the standard deviations
increases when the image qualities are “Poor” and therefore the scans are unusable.

From the high variability in the unusable scans, it is recommended that ‘Poor’ scans are
not to be used for clinical decision making due to their poor quality.

End of section
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11.4 Appendix D: iVue 100 NDB vs. RTVue NDB Substantial
Equivalence

The results in following Tables support substantial equivalence between the iVue 100
with NDB (K121739) and the predicate RTVue with NDB (K101505) for GCC
parameters, RNFL thickness parameters, Optic disc parameters, and Retina thickness
parameters. Mean differences were small and the ranges of differences are reasonably
tight for all thickness parameters associated with GCC scan, ONH scan, Retina map
scan, and iWellness scan. While the two devices may not be interchangeable due to the
small differences, considering each device is equipped with its own normative database
collected specifically for itself, it is reasonable to conclude that the two devices are
substantially equivalent.

Table 19. iVue 100 GCC Vs. RTVue GCC In Normal And Glaucoma Groups

LOA LOA
. X Mean | Mean mean of STDEV of 95%Cl of
iVue GCC vs. Subject . . lower | upper
of of Difference | Difference mean of
RTVue GCC s (n) . . boun | boun
iVue | RTVue s s Differences d d
Normal Group
GCC_Average 21 95.65 | 96.90 -1.25 2.92 (-2.577,0.077) | -7.77 5.27
GCC_Superior_Av (-2.681, -
g 21 95.89 | 97.25 -1.37 2.89 0.049) -8.14 5.41
GCC_lInferior_Avg 21 95.41 | 96.55 -1.13 3.21 (-2.595, 0.325) | -8.10 5.83
GCC_FLV 21 1.083 | 0.813 0.270 0.757 (-0.074, 0.614) | -1.519 | 2.059
GCC_GLV 21 3.964 | 4.146 -0.182 1.857 (-1.027,0.662) | -4.266 | 3.901
Glaucoma Group
(-1.974, -
GCC_Average 24 79.10 | 80.44 -1.34 1.50 0.709) -5.31 2.62
GCC_Superior_Av
g 24 79.75 | 80.76 -1.01 2.66 (-2.133,0.114) | -7.35 5.34
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LOA LOA
. i Mean | Mean mean of STDEV of 95%Cl of
iVue GCC vs. Subject . . lower | upper
of of Difference | Difference mean of
RTVue GCC s (n) i . boun | boun
iVue | RTVue s s Differences d p
(-2.591, -
GCC_lInferior_Avg 24 78.45 | 80.13 -1.67 2.17 0.758) -6.99 3.64
GCC_FLV 24 4.641 | 4.854 -0.213 1.328 (-0.773,0.347) | -3.445 | 3.019
14.64 16.81 (-2.626, -
GCC_GLV 24 8 3 -2.165 1.095 1.702) -5.280 | 0.951

Table 20. Normal And Glaucoma Groups iVue 100 ONH Vs. RTVue ONH (Disc Parameters)

Mean LOA LOA
iVue ONH vs. X Mea mean of STDEV of
X Subject of X X 95%Cl of mean | lower | upper
RTVue ONH (Disc n of Difference | Difference .
s (n) . RTVu of Differences | boun | boun
Parameters) iVue s S
e d d
Normal Group
(-0.256, -
Disc Area 21 1.916 | 2.090 -0.174 0.180 0.092) -0.528 | 0.179
(0.018,
Area C D ratio 21 0.300 | 0.261 0.038 0.044 0.0580) -0.057 | 0.134
H C D ratio 21 0.566 | 0.595 -0.029 0.087 (-0.068, 0.010) | -0.221 | 0.163
V C D ratio 21 0.462 | 0.479 -0.017 0.057 (-0.042,0.009) | -0.142 | 0.108
Cup Area 21 0.584 | 0.549 0.035 0.076 (0.000, 0.069) | -0.136 | 0.205
(-0.294, -
Rim Area 21 1.332 | 1.541 -0.209 0.187 0.124) -0.586 | 0.167
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Mean LOA LOA
iVue ONH vs. X Mea mean of STDEV of
X Subject of X X 95%Cl of mean | lower | upper
RTVue ONH (Disc n of Difference | Difference i
s (n) . RTVu of Differences | boun | boun
Parameters) iVue s s
e d d
(-0.121, -
Rim Volume 21 0.159 | 0.236 -0.077 0.097 0.032) -0.320 | 0.166
Nervehead (-0.118, -
Volume 21 0.334 | 0.409 -0.075 0.094 0.032) -0.320 | 0.169
Cup Volume 21 0.112 | 0.116 -0.004 0.028 (-0.016, 0.009) | -0.067 | 0.060
Glaucoma Group
Disc Area 23 2.035 | 1.952 0.083 0.246 (-0.023,0.189) | -0.399 | 0.566
Area C D ratio 23 0.599 | 0.586 0.013 0.089 (-0.025, 0.052) | -0.202 | 0.228
(-0.086, -
H C D ratio 23 0.800 | 0.854 -0.054 0.075 0.021) -0.220 | 0.113
(-0.120, -
V C D ratio 23 0.708 | 0.789 -0.081 0.093 0.040) -0.283 | 0.122
Cup Area 23 1.243 | 1.149 0.095 0.211 (0.003, 0.186) | -0.375 | 0.565
Rim Area 23 0.792 | 0.802 -0.011 0.222 (-0.106, 0.085) | -0.503 | 0.482
Rim Volume 23 0.068 | 0.067 0.001 0.019 (-0.006, 0.009) | -0.040 | 0.042
Nervehead
Volume 23 0.151 | 0.128 0.023 0.038 (0.006, 0.039) | -0.061 | 0.107
Cup Volume 23 0.341 | 0.328 0.013 0.095 (-0.028, 0.054) | -0.212 | 0.237
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Table 21. Normal and Glaucoma Groups iVue100 ONH Vs. RTVue ONH (RNFL

Parameters)
iVue ONH
LOA LOA
vs. RTVue . Mean | Mean mean of STDEV of
Subject . . 95%Cl of mean lower | upper
ONH (RNFL of of Difference | Difference i
s (n) . of Differences boun | boun
Parameters iVue | RTVue s S d d
)
Normal Group
100.4 104.8
Avg RNFL 21 2 5 -4.43 3.15 (-5.862, -2.991) -11.56 2.70
101.5 103.7
Sup RNFL 21 3 5 -2.23 5.28 (-4.630,0.179) -13.53 9.08
105.9
Inf RNFL 21 99.31 4 -6.63 4.54 (-8.697, -4.562) -16.73 3.47
Tempo 21 78.43 84.33 -5.91 6.20 (-8.728, -3.085) -21.60 9.79
118.1 121.7
Superior 21 7 9 -3.62 7.61 (-7.083, -0.154) -19.38 | 12.14
Nasal 21 74.99 | 78.76 -3.77 6.60 (-6.776,-0.765) | -20.26 | 12.71
130.0 | 134.5
Inferior 21 9 0 -4.41 6.50 (-7.369, -1.451) -18.30 9.48
TU 21 87.96 86.81 1.15 9.26 (-3.067, 5.362) -20.61 | 22.90
135.6 134.8
ST 21 4 2 0.82 6.96 (-2.352, 3.988) -14.57 | 16.20
100.7 108.7
SN 21 0 6 -8.05 10.89 (-13.008, -3.096) | -30.71 | 14.60
NU 21 81.80 84.62 -2.82 8.28 (-6.583, 0.951) -21.32 | 15.69
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iVue ONH
LOA LOA
vs. RTVue . Mean | Mean mean of STDEV of
Subject . . 95%Cl of mean lower | upper
ONH (RNFL of of Difference | Difference i
s (n) . of Differences boun | boun
Parameters iVue | RTVue s S d d
)
NL 21 68.18 72.97 -4.80 6.11 (-7.576, -2.016) -22.89 | 13.30
1115 119.7
IN 21 1 8 -8.27 7.89 (-11.864, -4.679) | -30.04 | 13.50
148.6 149.2
IT 21 8 1 -0.54 8.71 (-4.502, 3.430) -21.51 | 2044
(-15.837, -
TL 21 68.89 81.82 -12.93 6.39 10.022) -29.47 3.61
Glaucoma Group
Avg RNFL 23 78.17 81.54 -3.37 3.19 (-4.750, -1.989) -10.26 3.52
Sup RNFL 23 79.49 | 81.45 -1.96 3.89 (-3.644,-0.283) | -10.63 | 6.71
Inf RNFL 23 76.86 81.64 -4.78 4.79 (-6.847, -2.708) -14.89 5.33
Tempo 23 59.48 63.83 -4.36 4.82 (-6.442, -2.275) -16.20 7.48
Superior 23 93.17 96.03 -2.86 6.37 (-5.614, -0.105) -16.47 | 10.75
Nasal 23 63.19 66.37 -3.18 5.06 (-5.369, -0.990) -15.56 9.20
Inferior 23 96.87 99.96 -3.08 7.63 (-6.382, 0.214) -18.88 | 12.71
TU 23 64.95 | 64.15 0.80 6.00 (-1.796, 3.391) -13.91 | 15.51
102.8
ST 23 2 99.61 3.21 7.73 (-0.134, 6.547) -13.74 | 20.16
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iVue ONH
LOA LOA
vs. RTVue . Mean | Mean mean of STDEV of
Subject . . 95%Cl of mean lower | upper
ONH (RNFL of of Difference | Difference i
s (n) . of Differences boun | boun
Parameters iVue | RTVue s S d d
)
SN 23 83.52 92.41 -8.90 8.42 (-12.534, -5.255) | -26.56 8.77
NU 23 66.67 69.61 -2.94 5.05 (-5.127,-0.757) -15.74 9.86
NL 23 59.70 63.16 -3.46 6.82 (-6.409, -0.514) -19.45 | 12.52
IN 23 88.54 96.69 -8.14 9.29 (-12.160,-4.128) | -27.44 | 11.15
105.2 103.2
IT 23 0 4 1.96 9.23 (-2.035, 5.948) -17.36 | 21.27
TL 23 54.00 63.49 -9.49 6.48 (-12.293,-6.689) | -24.65 5.67
Table 22. Normal And Retina Groups iVue 100 Retina Map Vs. RTVue EMM5
iVue Retina . Mean | Mean LOA LOA
Subjects mean of STDEV of 95%Cl of mean
Map vs. of of i i . lower | upper
(n) . Differences | Differences | of Differences
RTVue EMM5 iVue | RTVue bound | bound
Normal Group
Fovea 21 260.21 | 258.65 1.56 4.29 (-0.395, 3.510) -9.07 12.18
Para Fovea 21 314.79 | 319.40 -4.61 6.87 (-7.736, -1.485) | -18.68 9.45
Para S.
Hemisphere 21 316.34 | 322.04 -5.70 7.97 (-9.325,-2.071) | -22.09 | 10.69
Para l.
Hemisphere 21 313.25 | 316.82 -3.57 6.38 (-6.475, -0.667) | -16.87 9.73
Para Tempo 21 307.67 | 310.90 -3.23 7.47 (-6.625,0.173) | -18.75 | 12.30

iScan User Manual

Page 172 of 181

P/N 580-49328-004 Rev. A




iVue Retina . Mean | Mean LOA LOA
Subjects mean of STDEV of 95%Cl of mean

Map vs. of of i i . lower | upper

(n) i Differences | Differences | of Differences

RTVue EMM5 iVue | RTVue bound | bound

Para Superior 21 317.09 | 323.86 -6.76 8.66 (-10.704,-2.821) | -24.63 | 11.10

Para Nasal 21 322.71 | 325.90 -3.18 8.01 (-6.828,0.463) | -20.19 | 13.82

Para Inferior 21 311.70 | 316.89 -5.19 6.56 (-8.177,-2.208) | -18.90 | 8.51

Peri Fovea 21 286.43 | 290.16 -3.73 5.95 (-6.441,-1.026) | -15.93 | 8.46

Peri S.

Hemisphere 21 289.58 | 291.01 -1.43 6.26 (-4.281,1.419) | -14.45 | 11.58

Peri l.

Hemisphere 21 283.27 | 289.27 -6.00 6.85 (-9.115, -2.876) | -20.72 8.72

Peri Tempo 21 278.59 | 282.36 -3.77 9.33 (-8.012,0.478) | -24.20 | 16.67

Peri Superior 21 288.50 | 287.40 1.11 6.14 (-1.687,3.903) | -12.38 | 14.59

Peri Nasal 21 301.59 | 308.02 -6.43 6.15 (-9.229, -3.629) | -19.75 | 6.89

Peri Inferior 21 277.02 | 282.75 -5.73 7.98 (-9.359, -2.094) | -22.92 | 11.46

Retina Group

Fovea 19 297.60 | 293.11 4.50 1.85 (3.605, 5.386) -4.94 13.93

Para Fovea 19 327.57 | 325.25 2.31 5.37 (-0.276, 4.902) -9.23 13.85

Para S.

Hemisphere 19 330.69 | 327.29 3.40 9.61 (-1.233,8.026) | -16.89 | 23.69

Para l.

Hemisphere 19 324.45 | 323.31 1.14 3.67 (-0.628, 2.911) -7.77 10.06
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iVue Retina . Mean | Mean LOA LOA
Subjects mean of STDEV of 95%Cl of mean

Map vs. of of i i . lower | upper

(n) i Differences | Differences | of Differences

RTVue EMM5 iVue | RTVue bound | bound

Para Tempo 19 328.04 | 324.88 3.16 7.11 (-0.266, 6.588) | -12.07 | 18.39

Para Superior 19 330.69 | 327.51 3.18 13.22 (-3.189,9.551) | -24.66 | 31.02

Para Nasal 19 331.07 | 327.80 3.27 7.18 (-0.195,6.729) | -13.08 | 19.62

Para Inferior 19 320.48 | 320.95 -0.47 4.62 (-2.699, 1.755) | -11.96 | 11.02

Peri Fovea 19 291.19 | 288.67 2.52 5.05 (0.089, 4.954) -7.76 12.81

Peri S.

Hemisphere 19 294.75 | 290.30 4.45 10.48 (-0.595,9.504) | -16.69 | 25.60

Peri l.

Hemisphere 19 287.62 | 287.08 0.55 5.49 (-2.101, 3.192) | -11.16 | 12.25

Peri Tempo 19 288.82 | 285.95 2.87 6.29 (-0.161,5.902) | -11.91 | 17.65

Peri Superior 19 292.12 | 286.32 5.80 14.20 (-1.046, 12.638) | -22.99 | 34.58

Peri Nasal 19 303.39 | 301.97 1.42 8.79 (-2.816,5.653) | -17.15 | 19.99

Peri Inferior 19 280.42 | 280.37 0.06 7.52 (-3.568, 3.678) | -15.59 | 15.70
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Table 23. Normal And Glaucoma Groups iVue 100 iWellness vs. RTVue GCC (GCC

Parameters)
iVue iWellness LOA LOA
. Mean | Mean mean of STDEV of 95%Cl of
vs. RTVue GCC Subject X X lower | upper
of of Difference | Difference mean of
(GCc s (n) . . boun | boun
iVue | RTVue s s Differences
Parameters) d d
Normal Group
(-3.062, -
GCC Average 21 95.01 96.86 -1.86 2.65 0.650) -7.73 4.02
GCC Superior (-3.085, -
Avg 21 95.30 | 97.14 -1.85 2.72 0.608) -8.15 4.46
(-3.150, -
GCC Inferior Avg 21 94.73 | 96.59 -1.86 2.83 0.573) -8.01 4.29
GCC FLV 21 0.976 | 0.784 0.193 0.652 (-0.104, 0.489) | -1.351 | 1.736
GCC GLV 21 3.871 | 4.259 -0.389 1.802 (-1.208, 0.431) | -4.118 | 3.340
Glaucoma Group
(-2.752, -
GCC Average 23 79.13 81.11 -1.98 1.78 1.208) -6.21 2.25
GCC Superior (-3.340, -
Avg 23 79.14 | 81.42 -2.27 2.47 1.206) -8.05 3.51
(-2.429, -
GCC Inferior Avg 23 79.10 | 80.79 -1.69 1.72 0.944) -6.11 2.73
GCC FLV 23 5.056 | 4.504 0.552 1.085 (0.082,1.020) | -2.249 | 3.352
12.67 16.12 (-4.164, -
GCC GLV 23 2 5 -3.453 1.645 2.741) -7.353 | 0.447

iScan User Manual Page 175 of 181 P/N 580-49328-004 Rev. A



Table 24. Normal And Retina Groups iVue 100 iWellness Vs. RTVue EMM5 (Retina

Parameters)
iVue iWellness LOA
mean of STDEV of LOA

vs. RTVue Subjects | Mean of Mean of 95%Cl of mean | lower

Difference | Difference upper
EMMS5 (Retina (n) iVue RTVue of Differences boun

s s bound

Parameters) d
Normal Group
Fovea 21 258.40 258.61 -0.20 5.55 (-2.730, 2.323) | -12.05 11.64
ParaFovea 21 317.10 317.75 -0.65 7.15 (-3.902, 2.611) | -15.20 13.91
ParaS.
Hemisphere 21 318.63 319.73 -1.10 8.64 (-5.032, 2.837) -18.60 16.41
Para l.
Hemisphere 21 315.57 315.64 -0.08 6.40 (-2.988, 2.838) | -13.30 13.15
Para Tempo 21 307.71 310.16 -2.45 8.43 (-6.290, 1.387) -19.70 14.79
Para Superior 21 322.94 321.44 1.50 8.64 (-2.433,5.432) | -16.16 19.16
Para Nasal 21 320.39 323.54 -3.15 8.15 (-6.857,0.563) | -20.23 13.94
Para Inferior 21 317.36 315.58 1.78 7.16 (-1.482,5.039) | -12.95 16.50
PeriFovea 21 287.25 288.26 -1.02 6.08 (-3.783, 1.749) -13.32 11.28
Peri S.
Hemisphere 21 290.94 289.63 131 7.14 (-1.941, 4.555) -13.26 15.87
Peri l.
Hemisphere 21 283.55 286.92 -3.37 6.53 (-6.342,-0.401) | -17.02 10.27
Peri Tempo 21 278.40 279.97 -1.57 8.95 (-5.646, 2.506) | -20.47 17.33
Peri Superior 21 290.76 286.32 4.44 7.79 (0.896,7.989) | -11.65 20.53
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iVue iWellness

LOA

mean of STDEV of LOA

vs. RTVue Subjects | Mean of Mean of 95%Cl of mean | lower

Difference | Difference upper
EMMD5 (Retina (n) iVue RTVue of Differences boun

s s bound

Parameters) d
Peri Nasal 21 302.44 306.66 -4.22 7.97 (-7.850, -0.593) | -20.64 12.20
Peri Inferior 21 277.38 280.06 -2.68 7.61 (-6.144, 0.787) -18.80 13.45
Retina Group
Fovea 16 278.96 276.71 2.24 3.71 (0.269, 4.218) -6.09 10.57
ParaFovea 16 318.55 315.23 3.32 4.94 (0.684, 5.953) -6.77 13.41
Para S.
Hemisphere 16 320.32 317.10 3.22 6.65 (-0.325, 6.757) -10.42 16.85
Para l.
Hemisphere 16 316.78 313.46 3.32 5.40 (0.442,6.193) -7.83 14.47
Para Tempo 16 311.60 308.58 3.02 7.33 (-0.885, 6.922) -12.85 18.88
Para Superior 16 323.57 319.10 4.47 8.32 (0.037, 8.901) -12.51 21.45
Para Nasal 16 322.46 321.10 1.36 5.41 (-1.523, 4.242) -10.37 13.08
Para Inferior 16 316.55 312.29 4.26 6.37 (0.869, 7.655) -9.11 17.64
PeriFovea 16 285.46 283.14 2.33 5.60 (-0.658, 5.313) -8.99 13.65
Peri S.
Hemisphere 16 289.42 285.44 3.99 10.05 (-1.367, 9.338) -16.35 24.32
Peri I.
Hemisphere 16 281.50 280.84 0.66 3.97 (-1.458, 2.775) -7.95 9.27
Peri Tempo 16 275.39 271.74 3.65 4.65 (1.171, 6.128) -8.39 15.69
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iVue iWellness LOA
mean of STDEV of LOA

vs. RTVue Subjects | Mean of Mean of 95%Cl of mean | lower

Difference | Difference upper
EMMD5 (Retina (n) iVue RTVue of Differences boun

s s bound

Parameters) d
Peri Superior 16 288.93 283.61 5.31 12.99 (-1.607,12.231) | -20.95 31.57
Peri Nasal 16 301.53 301.41 0.12 7.71 (-3.990, 4.228) -16.20 16.44
Peri Inferior 16 276.01 275.66 0.35 5.87 (-2.776, 3.484) -12.11 12.82

End of section
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3D Retina Display, 73

3D retina optional views, 73

About iVue—Help menu, 126

Add New Patient optional fields, 37

Add Patient button, 37

Add Visit shortcut, 37

Additional Technical specifications,
141

Allow Save Eye Blink Data—in User
Preference, 118

Angle (Cornea) scan scan
orientation, 132

Angle tool, 62

Annotate tool, 62

APPENDIX 11 — Precision Data for
iVue 100 with NDB, 144

APPENDIX 12 — Scan Quality Index,
162

APPENDIX 13 — iVue 100 NDB vs.
RTVue NDB Substantial
Equivalence, 167

Archive Data, 112

Archive Drive—in User Preference,
119

Archive Selection from File menu,
115

Archive steps, 115

Audio Commands, 45

Audio Commands table, 46

Auto Adjustment, 49

Auto F—manual scan adjustment,
120

Auto P—manual scan adjustment,
121

Auto Z—manual scan adjustment,
120

Auto-Adjust button, 54

Auto-Adjustment Complete, 50

auto-adjustments, 50

Baseline Control Buttons, 84
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Batch Process, 116

B-Scan button in Tool menu, 97

calibration verification, 129

CAM lens, 43

Capture, 50

Clean and Batch Process All Patients
Data, 117

Clean diagnosis data, 117

Compliance specifications, 140

Computer Maintenance, 129

Computer specifications, 140

Controls in 3D Disc report, 84

Cornea Angle OU Report, 107

Cornea Angle Scans, 55

Cornea Change Analysis, 101

Cornea Imager specifications, 139

Cornea Pachymetry Analysis
Presentation, 97

Cornea Pachymetry Report, 97

Cornea Scan fixation pattern, 138

Cornea Scan Results (Standard
Deviation) table, 164

Corneal, 55

Corneal audio commands, 46

Create New Visit, 38

Cross Line scan scan orientation, 132

Data Transfer, 112

Database Management Dropdown
Menu, 123

Date Format—in User Preference
dialog, 118

date of birth format change, 38

Delete Patient shortcut, 37

Delete Patient Warning Message, 39

Delete Visit shortcut, 37

Disease Editor dialog, 124

Distance tool, 62

Edit button, 39

Edit Patient or Visit Information, 39

EMR ID search, 36
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EMR, Electronic Medical Records, 36

Equipment Classification, 13

ETDRS Centering on Fovea with
figures, 67

external fixation, 55

Eye Distance Arrows, 53

Factors that Can Affect Accuracy of
Thickness Measurements, 98

File Menu options, 110

Focal Loss Volume, 90

Frame Average Property, 121

GCC Change Analysis Report, 91

GCC Map Scan and iWellness fixation
pattern, 137

GCC OU Report, Two Visits, 93

GCC Scan Results (Standard
Deviation) table, 165

GCC thickness map examples, 89

Glaucoma Scan Results (Standard
Deviation) table, 164

Global Loss Volume, 90

Green Arrows: Left, Right, Up, Down
for scan correction, 51

Hemisphere and Quadrant Maps, 76

Image Quality Classification Based
On SQlI Cutoffs table, 162

Indications For Use, 13

Instrument Description, 30

Introduction, 12

Invert tool, 62

Iris Imager specifications, 139

iVue 100 GCC Vs. RTVue GCC In
Normal And Glaucoma Groups
table, 167

iVue 100 NDB vs. RTVue NDB
Substantial Equivalence, 167

iWellness analysis, 107

iWellness Scan Pattern, 136

iWellness Scan Results (Standard
Deviation) table, 166

Lens Home and Forward positions,
44

Line tool, 62

iScan User Manual
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Main Boundary Adjustment, 77

Main Menu Toolbar, 110

Maintenance And Troubleshooting,
128

Manual Adjustments, 53

Manual Boundary Adjustment, 97

manual control enabled, 52

manual scan alignment, 48

Marginally Significant Change on p-
value chart, 96

Modified Disc Baseline, 86

Modify Boundary, 122

Modify Disc Baseline, 77, 86, 121

Modify RPE Anchor Points, 83

Move a visit to another patient, 124

Multiple Scans, 44

Multi-Visit Nerve Fiber GCC Change
Analysis, 92

NDB Reference Map, 89

NDB references--only for full retinal
thickness, 64

Nerve Fiber 3D Disc Report, 84

Nerve Fiber Change Report, 79

Nerve Fiber GCC Report, 88

Nerve Fiber GCC Report With
Parameters Table, 90

Nerve Fiber ONH Change Analysis,
79

Nerve Fiber ONH OU Report, 81

Nerve Fiber ONH Report, 74

Nerve Fiber ONH scan orientation,
132

Nerve Fiber ONH Scan Pattern, 133

New Patient, 37

Normal And Glaucoma Groups iVue
100 iWellness vs. RTVue GCC (GCC
Parameters) table, 175

Normal And Glaucoma Groups iVue
100 ONH Vs. RTVue ONH (Disc
Parameters) table, 168

Normal and Retina Groups iVue 100
Retina Map Vs. RTVue EMMS5 table,
172
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Normative Database, 142; limitations
for patient comparison, 64

OCT noise tool, 62

ONH and 3D Optic Nerve Scan
fixation pattern, 137

ONH Change Analysis Report, 94

ONH map registration, 60

ONH scan, 54

Operating Conditions specifications,
140

Operator Editor dialog, 124

OU Report for Cornea Scan, 100

out of bounds OCT data affects SQl,
61

Pachymetry (Cornea) scan scan
orientation, 132

Pachymetry Assessment table, 97,
103

Pachymetry map, 97

Pachymetry Scan: Place Cornea
Image Between Red Lines, 57

Pachymetry Scan Pattern, 135

Pachymetry scans, 56

Patient Deletion Warning Message,
37

Patient Interface specifications, 139

Patient List shortcuts, 39

Patient List Shortcuts, 37

Patient Scanning Screen, 42

Patient Window, 35

PATIENT window, 35

Physician Editor dialog, 123

Power specifications, 140

Precision for Normal and Cornea
Patient Scans, 98

Primary Backup Drive—in User
Preference, 119

Print Setup, 111

Product Label, 29

protective packing symbols, 28

Pupil centered, 48

realtime video: Software-assisted
mode, near camera, 48

iScan User Manual
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Recycling Label, 30

red lines for centering corneal image,
56

red stop button, 53

Repeatability and Reproducibility of
Disc and RNFLThickness
(Glaucoma Eyes) table, 159

Repeatability and Reproducibility of
GCC (Glaucoma Eyes) table, 150

Repeatability and Reproducibility of
GCC (Normal Eyes) table, 149

Repeatability and Reproducibility of
GCC (Retina Disease Eyes) table,
149

Repeatability and Reproducibility of
GCC and Retina Thickness
(Glaucoma Eyes) table, 154

Repeatability and Reproducibility of
GCC and Retina Thickness (Normal
Eyes) table, 150

Repeatability and Reproducibility of
GCC and Retina Thickness (Retina
Disease Eyes) table, 152

Repeatability and Reproducibility of
Retina Thickness (Glaucoma Eyes)
table, 148

Retina 3D Analysis Presentation, 72

Retina 3D En Face tab, 73

Retina 3D SLO tab, 73

Retina 3D Thickness tab, 73

Retina Cross Line Default Display—in
User Preference, 119

Retina Cross Line Report, 70, 71

Retina Map Change Report, 68

Retina Map Default Display Map—in
User Preference, 119

Retina Map scan scan orientation,
132

Retina Map With Reproducibility SD
Values Table, 64

Retina Map Without Reproducibility
SD Values, 63

Retina Scan fixation pattern, 137
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Retina Scan Pattern, 134

Retina Scan Results (Standard
Deviation) table, 163

Review Screen sample, 59

RFE Tip Verification, 83

RNFL Thickness Map, 76

Save Report as JPG tool, 62

Scan Auto Save—in User Preference,
119

scan button, 39

Scan button, 38

Scan Image Quality—factors
affecting, 61

Scan Orientation convention, 132

Scan Patterns table, 131

Scan quality factors affecting, 78

Scan Quality Index Comparison table,
60

Scan Window, 41

Scanner specifications, 139

Scanning controls: 3 rows of buttons,
42

Secondary Archive Drive—in User
Preference, 119

Secondary Backup Drive—in User
Preference, 119

Segmentation lines, 122

Segmentation lines with modified
boundaries, 122

Service Policy, 2

iScan User Manual
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Set Up Primary and Secondary USB
Drives, 113

Significant Change on p-value chart,
96

SQI: Scan Quality Index, section, 60

Standard Accessories—Applicable
manuals, 19

start button--green, 52

Storage Conditions specifications,
141

System Configuration, 14

System Front View, 14

System Warnings, 15

Technical Specifications, 139

Tool pane, 62

Tools, 62

Tools Menu, 118

Transport Conditions specifications,
141

Transport—Lock Base Before Moving
System, 20

Unpacking the System, 31

unreliable measurements—
conditions, 47

Upgrade Features Menu, 127

User Preference Dialog, 38

Verify RPE tips, 83

Video Disc Baseline Editor, 121

View B-scans tool, 62

View Reproducibility checkbox, 77

Warranty Information, 2
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